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I

1

Introduction
Thank you for purchasing the NCC-001 Progressive Nitrous Control Center by Lingenfelter Performance
Engineering. There are few Nitrous Controllers on the market that can come close to the feature set offered by the
Lingenfelter Performance Engineering (LPE) NCC-001 Nitrous Control Center. The NCC-001 is capable of
controlling up to four stages of nitrous (if the fuel supply is controlled by the ECM or other method), with many
different available triggering and disabling input options available for each. The NCC-001 controller interface is
designed for ease of use and access at the track as all of the settings and options available in the NCC-001
software program are also available on the controller itself. The NCC-001 controller also features enough internal
memory to save three user-defined nitrous programs for quick access in the case that track conditions change
and a different setup is desired.
While the NCC-001 Nitrous Control Center can be installed into virtually any vehicle, it was especially designed for
late model EFI vehicles. Special attention was paid to integrating the NCC-001 into GM LS powered vehicles
including:
1998-2002 Camaro
1997-2012 Corvette
2010-2013 Camaro SS
2004-2006 Pontiac GTO
The features alluded to already, as well as the numerous other features listed in the following section, make the
NCC-001 Nitrous Control Center from Lingenfelter Performance Engineering one of the most advanced Nitrous
Controllers available while still offering the ease of use that renders it practical for seasoned race veterans and
weekend racers alike.

5

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

1.1

NCC-001 Features
Two independent progressive stages of nitrous and fuel
o Independent control of both nitrous and fuel duty cycle for each stage
o Four stages of nitrous (if used to only control nitrous solenoids)
Timer/RPM based output (+12V)
Relay output (+12V) - programmable based on any combination of: Arming input, clutch input, shift input, TPS
%, AFR, Nitrous1 %, Fuel1 %, Nitrous2 %, Fuel2 %, RPM, MPH, Fuel PSI, Nitrous PSI
Relay output (Ground) - programmable based on any combination of: Arming input, clutch input, shift input, TPS
%, AFR, Nitrous1 %, Fuel1 %, Nitrous2 %, Fuel2 %, RPM, MPH, Fuel PSI, Nitrous PSI
Shift light output, +12 volt
Analog voltage output, programmable - for sending to a data acquisition system or to an ECM for external fuel or
spark control. Also can link to the LNC-2000 for progressive timing retard on GM LSx V8 engine vehicles.
PWM output (for future features - not currently enabled in the software)
5 volt and ground output for Fuel Pressure and Nitrous Pressure sensors (for improved signal accuracy)
Arming input (Ground or +12 volt selectable)
Clutch input - for clutch switch, linelock, or transbrake input (Ground or +12 volt selectable)
Shift input - for gear position (Ground or +12 volt selectable)
Nitrous bottle pressure input, 0-5 volt
Fuel pressure input, 0-5 volt
AFR input, 0-5 volt
TPS input - accepts rising and falling voltage signal sensors, 0-5 volt
Two analog inputs - accepts rising and falling voltage clutch position sensors, 0-5 volt
Frequency input (vehicle speed, possible other inputs later)
o Software enable/disable pull-up resistor on frequency input
Engine speed (tach) input
o Software enable/disable pull-up resistor on tachometer input
o Accepts most engine configurations
Time based safety over-ride
Fuel pressure safety over-ride
Air fuel ratio safety over-ride
Closed loop bottle heater control (using relay output and nitrous pressure input)
Time based nitrous control
RPM based nitrous enable
MPH based nitrous enable
Gear position based nitrous enable
Independent Stage 1 and Stage 2 delay adjustments
User configurable between Hold & Wait or full reset when activation is removed and re-enabled. Hold & Wait
resumes the progressive system at the point where the system was disabled (for example, where the throttle
was released).
Independent Stage 1 and Stage 2 nitrous and fuel resume ramp rates
Independent Stage 1 and Stage 2 fuel advance settings > These settings allow you to fine tune the system so
that the low pressure fuel is delivered to the engine at the same time or before the high pressure nitrous, helping
reduce the chances of initial lean spikes when each stage of nitrous is activated
Multiple solenoid frequency settings (independent for Stage 1 & 2)
PC programmable USB interface software - Windows XP, Vista, and 7 compatible.
No PC required - can be programmed at the unit
Built in display to view inputs, outputs and settings
Data logging built in (PC required to read and view data). All channels logged at 100 samples second. 25
second logging time.
Nitrous user settings stored in each data log for ease of recalling past nitrous settings.
Free software updates (PC and Internet access required)

Introduction
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1.2

NCC-001 Warnings
DO NOT submerge the NCC-001 controller in liquid or directly wash the controller with a liquid of any
type.
It is the responsibility of the purchaser to follow all guidelines and safety procedures provided within
this manual, as well as any other manufacturer's product that will be used in the installation or
operation of the NCC-001 Nitrous Control Center.
It is the responsibility of the purchaser to follow all guidelines and safety procedures supplied with
this product and any other manufacturer’s product used with this product. It is also the responsibility
of the purchaser to determine compatibility of this device with the vehicle and other components.
Lingenfelter Performance Engineering assumes no responsibility for damages resulting from
accident, improper installation, misuse, abuse, improper operation, lack of reasonable care, or all
previously stated reasons due to incompatibility with other manufacturer’s products.
Lingenfelter Performance Engineering assumes no responsibility or liability for damages incurred
from the use of products manufactured or sold by Lingenfelter Performance Engineering on vehicles
used for competition racing. Lingenfelter Performance Engineering neither recommends nor
approves the use of products manufactured or sold by Lingenfelter Performance Engineering on
vehicles which may be driven on public highways or roads, and assumes no responsibility for
damages incurred from such use.
The NCC-001 Nitrous Control Center are intended for use in the controlled environment of a racing
facility. NEVER use a nitrous oxide injection system on public roadways as it may be illegal, but also
extremely dangerous.
It is the purchaser's responsibility to check the state and local laws pertaining to the use of nitrous
oxide for racing applications. Lingenfelter Performance Engineering denounces the use of its
products in illegal street racing activities.
LPE recommends that nitrous safety solenoids be used anytime the primary nitrous solenoids are
pulse-width modulated. The use of nitrous safety solenoids allow the flow of nitrous to be terminated
in the event that either of the primary nitrous solenoids get stuck open.
Before switching the NCC-001 Nitrous Control Center ON for the first time, check the wiring to verify
that all wires are correctly routed and securely attached to the controller. Incorrect wiring of the
NCC-001 could potentially lead to damage of the controller, as well as the vehicle itself.
LPE strongly recommends that you position your nitrous bottle pressure sensor on the tank side of the
nitrous bottle valve. If the nitrous pressure sensor is located on the tank side of your nitrous bottle
valve, the valve can be closed between runs as the sensor can still sense the bottle pressure while it
is being heated. If your nitrous pressure sensor is located on the outgoing side of your valve, the
valve must stay open anytime the bottle is being heated so that the nitrous pressure sensor can
regulate the pressure. Heating the bottle with the pressure sensor on the outgoing side of the valve
and the valve shut could potentially cause an extremely dangerous over-pressure condition. If you
choose to position your nitrous bottle pressure sensor on the outgoing side of the nitrous bottle valve,
you will be doing so at your own risk. Per NHRA rules, the bottle's over-pressure safety disk should be
connected to a blow down tube that allows nitrous to be vented out of the vehicle in the event that
the safety disk ruptures. Before using the nitrous bottle(s), make sure that they are properly secured
to the vehicle. If using a bottle heater, make sure that the bottle heater is properly secured to the
bottle and that it lays completely flat around the bottle.
All electrical joints, as well as any other places where exposed wires are present, should be
sufficiently insulated using heat shrink tubing and possibly electrical tape. Failure to do so could lead
to damage to the wires, as well as the electrical components that they are connected to.
The NCC-001 Nitrous Control Center is designed to be mounted somewhere in the passenger
7
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compartment of the vehicle. Do not mount the NCC-001 where it could be exposed to extreme heat,
such as the engine compartment.
LPE recommends the use of resistor type spark plugs and RFI (radio frequency interference) and EMI
(electromagnetic interference) suppression spark plug wires on all EFI engines, as well as any vehicle
that has electronic control modules on board (including the NCC-001). Failure to do so may result in
erratic operation of not just the NCC-001, but all electrical control modules in the vehicle.

1.3

Limited Warranty
LPE warrants the Lingenfelter NCC-001 Nitrous Control Center to be free from defects in material and
workmanship under normal use and if properly installed for a period of 180 days from date of purchase.
If the controller is found to be defective as mentioned above, it will be replaced or repaired if returned
prepaid along with proof of date of purchase. This shall constitute the sole remedy of the purchaser and
the sole liability of LPE. To the extent permitted by law, the foregoing is exclusive and in lieu of all
other warranties or representations whether expressed or implied, including any implied warranty of
merchantability or fitness. In no event shall LPE be liable for special or consequential damages.

Introduction
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1.4

NCC-001 Notes
For the sake of simplicity, options and settings that are accessed through either the Nitrous1 (N2O-1) or
Nitrous2 (N2O-2) menus will by accompanied by an illustration of the setting for Nitrous1 only. Note that the
Nitrous1 and Nitrous2 menus have the exact same options and settings—they just control different nitrous
stages.
Many of the wiring descriptions and diagrams for the NCC-001 in this manual assume you have the optional
NCC-001 wiring harness (PN: L480310000). This harness features wires that are pre-labeled with the NCC-001
terminal labels, as well as ring terminals with heat shrink insulation on one end.
The wiring descriptions and diagrams in this manual that involve connecting the NCC-001 to a fuel or nitrous
pressure sensor assume that you have the optional fuel pressure harness (PN: L480290000) and nitrous
pressure harness (PN:L480300000). These harnesses feature wires that are pre-labeled with the applicable
NCC-001 terminal labels, as well as ring terminals with heat shrink insulation on one end.
The NCC-001 is not designed for use on aircrafts.
Because the Nitrous Control Center computer software and the NCC-001 firmware are not organized in the same
way, settings and options are not necessarily found in the same places on both platforms. The options and
settings described in this instruction manual are organized in the same manner as the NCC-001 controller.
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Parts List

Part

II

2

Parts List

Quantity
1
1
1
4
26
1
2
1
1

2.1

Description
NCC-001 Nitrous Control Center
USB drive loaded with NCC-001 software
6ft USB 2.0 A Male to Mini-B 5pin Male 28/24AWG Cable w/ Ferrite Core (Gold
Plated)
Self-tapping screws, #6
Slotted ring terminal, 16-22 AWG
LPE 9" decal
LPE bumper stick & sponsor decal, 10-3/4 x 3-1/4"
Binder
Instructions

MONO-8634
99663A156
DK321288
L920010000
L920180000

Additional Required Components
Description
Nitrous solenoids
Fuel solenoids (unless supplying fuel by other means)
Nitrous tank
Nitrous bottle heater
Nitrous filter

2.2

Item ID/PN
NCC-001

Item ID/PN

Tools & Materials Required
Wire stripper
Wire crimper
Heat shrink tubing
Heat source for heat shrink tubing (heat gun, lighter, etc...)
Phillips head screwdriver
Wires of various color, length, and gauge
Electrical connector pin removal tool
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2.3

Optional Items
Description
0-15 psi pressure sensor (for fuel pressure)
0-150 psi pressure sensor (for fuel pressure)
0-2000 psi pressure sensor (for nitrous pressure)
Fuel pressure sensor harness, 10 ft
Nitrous pressure sensor harness, 10 ft
NCC-001 harness, 10 ft
LNC-2000 Launch Control Module with timing retard feature
Red LED 7 warning light, 10 ft two wire cable
Red LED lighted paddle toggle switch, 20 amp
Sealed 40 amp relay kit
Holley EFI nitrous solenoid driver
Wide open throttle (WOT) switch
E38 terminal

Item ID/PN
L480250015
L480260150
L480272000
L480290000
L480300000
L480310000
L460145297
RP-WLRBLK001
DC-7600500
L450100000
554-111
N/A
0334680003

0-15 PSI fuel pressure sensor (PN: L480250015)

0-150 PSI fuel pressure sensor (PN: L480260150)

0-2000 PSI nitrous pressure sensor (PN: L480272000)

Fuel sensor harness (PN: L480290000)

Parts List
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Nitrous sensor harness (PN: L480300000)
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NCC-001 harness (PN: L480310000)
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Installation of the NCC-001 Nitrous
Control Center

Part

III

3

Installation of the NCC-001 Nitrous Control Center
The following subsections detail the installation of both the NCC-001 controller in the vehicle, as well as the
Nitrous Control Center and NCC Controller Flash Utility software programs onto a personal computer. In the
following subsections that cover the installation of the controller itself, several wiring configurations have been
provided to give you ideas of how the controller can be installed. Please note that a combination of these
configurations may be necessary to achieve your desired operation. In the subsections that cover the installation
of the Nitrous Control Center and NCC Controller Flash Utility software, the installation steps described should be
explicitly followed in order to properly install the software. If the software is being installed on a Windows Vista or
Windows 7 equipped computer, some of the screens and dialog boxes may differ slightly from the screen shots
provided in this manual as the example installation was done on a Windows XP equipped computer.

3.1

Installation of the NCC-001 Hardware
The following sub-sections detail the installation of the NCC-001 Nitrous Controller in a vehicle. Each sub-section
will have a description of the configuration and a wiring diagram. Please note that the following configurations
represent just a small number of possible wiring configurations for the NCC-001 Controller. The optional NCC-001
wire harness (PN: L480310000) is composed of 22 color-coded wires (10 feet in length) that are all individually
labeled on their insulation. Make sure that each of the wires required for the desired configuration are correctly
installed into their respective terminals. If you choose not to use the optional NCC-001 wire harness, use the
supplied terminals to make your own harness. The terminals on the NCC-001 will accept 16-22 AWG wire. It is
recommended that the controller ground wires, the controller +12 volt power wires, and the solenoid ground wires
should all be 16 gauge wire. All other wires can be 20 gauge wire. Refer to Appendix C: Tables and Diagrams for
a chart showing the recommended gauge for a length of wire based on current draw and voltage drop. After
crimping a terminal to one end of the wire, use heat shrink tubing to seal and insulate the end going to the NCC001 to reduce the chance of a short circuit.
The configurations that will be shown in the following sub-sections are:
Progressive Nitrous Without Fuel Control
One Stage of Progressive Nitrous and Fuel
Two Stages of Progressive Nitrous and Fuel
NCC-001 Controlling the Solenoids Via Nitrous Solenoid Driver
NCC-001 Controlling Nitrous Solenoids Via Relays
NCC-001 Controlling a Bottle Heater
NCC-001 Connected to the LPE LNC-2000 Launch Controller
NCC-001 Connected to the LNC-2000 for Simple On/Off Control
NCC-001 Connected to the Pin on the ECM for EFILive Nitrous Operating System and Fuel Control
Connecting the NCC-001 to Throttle Position Sensors on Mechanical and Electronic Throttle Vehicles
NCC-001 Connected to the Clutch Position Sensor
NCC-001 Connected to the Clutch Position Switch
Converting a CPP Sensor Signal Into a 12 Volt Signal Via Conversion Module
NOTE: The wire colors in the wiring diagrams below will most likely differ from the wiring in your
vehicle. Identify the wires of all applicable components in your vehicle and confirm their individual
functions before beginning to wire the NCC-001 controller.
WARNING: LPE recommends that Nitrous safety solenoids be used anytime the primary solenoids are
pulse-width modulated. The use of nitrous safety solenoids allow the flow of nitrous to be terminated in
the event that either of the primary nitrous solenoids get stuck open.
NOTE: The wiring of the NCC-001 Nitrous Controller may require additional lengths of wire depending
on where the NCC-001 will be mounted on the vehicle.
NOTE: The wire harness colors described in this installation manual assume that you are installing the
optional NCC-001 wiring harness.
Refer to Appendix C: Tables and Diagrams for assistance in determining the proper RPM pulse count, engine
speed wiring locations, vehicle speed wiring locations, etc.
15
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3.1.1

Progressive Nitrous Without Fuel Control
Use this configuration to control the nitrous solenoids, but not the fuel solenoids. This configuration is known as
"Dry Nitrous" due to the controller not providing fuel control. Users installing the controller in this configuration will
still need to supply the fuel, just through means other than the controller itself. Two examples of ways to achieve
the proper fueling with this configuration are:
Use the Relay Output to trigger the nitrous/E85 mode in the ECM via the EFILive Ethanol Custom Operating
System, as shown in Section 3.1.7.
Connect the Analog Output to an auxiliary injector controller or aftermarket ECM input.
NOTE: Because the fuel solenoids are not controlled using this configuration, a third and fourth stage of
nitrous could be achieved by connecting the third and fourth nitrous solenoids to the "Fuel Solenoid 1"
and "Fuel Solenoid 2" outputs on the NCC-001 nitrous controller. The third and fourth nitrous solenoids
would then be configured by changing the "Fuel1" and "Fuel2" graphs.
WARNING: Nitrous solenoids are capable of drawing massive amounts of current, which can allow the
NCC-001 to see too much current and to possibly overheat. The NCC-001 controller is rated to withstand
a maximum, non-sustained current of 20 amps per solenoid channel from the nitrous and fuel solenoids.
For higher current applications, LPE recommends using relays so that the controller does not see too
much current.
WARNING: DO NOT leave the nitrous arming switch ON as it can overheat the safety solenoids.
Connect the solid red wire labeled "12 VOLT PWR" to the "+12 Volt" terminal on the NCC-001 and to a fused
(15 amp) and switched 12 volt DC source.
Connect the solid black wires labeled "GROUND1" and "GROUND2 to the "Ground1" and "Ground2" terminals
on the NCC-001 and to the battery ground stud. Be sure to connect BOTH ground wires. Since the NCC-001
controls the ground side of the solenoids, much more current will travel through the ground side of the NCC-001
than the +12 Volt side.
Connect the yellow wire labeled "ARMING INPUT" to the "Arming Input" terminal on the NCC-001, through a
WOT switch (alternatively, the TPS can be connected to the TPS Input), and to one of the wiring terminals on
the Nitrous Arming Switch. The Nitrous Arming Switch output should then be connected to the input of the
nitrous solenoid(s). If the combined current load of the nitrous and/or fuel solenoids exceeds the capacity of the
NCC-001, LPE recommends controlling the solenoids via relays. Depending on the current rating and quantity
of the solenoids you are using, it may be necessary to use separate relays for each of the nitrous stages. If
using relays to control the solenoids, see example wiring instructions in section 3.1.3.
Connect the striped dark brown wire labeled "N2O SLND 1" to the "N2O Solenoid1" terminal on the NCC-001
and to the ground side of Nitrous Solenoid 1.
If a second stage of nitrous is desired, connect the striped green wire labeled "N2O SLND 2" to the "N2O
Solenoid2" terminal on the NCC-001 and to the ground side of Nitrous Solenoid 2.
If the user desires to activate the nitrous using engine speed, to data log the RPM, or to control a shift light,
connect the striped white wire labeled "TACH INPUT" to the "Tach Input" terminal on the NCC-001 and to a
suitable RPM Signal Source. The RPM signal source could be the tachometer output lead of the vehicle, the
switched side of the ignition coil (negative side), or the 5 volt RPM reference signal. See Appendix C: Tables
and Diagrams for the location of the tachometer output wiring on some common GM vehicles.
If the addition of a shift indicator light is desired, connect the solid green wire labeled "SHIFT LIGHT" to the
"Shift Light, +12V" terminal on the NCC-001 and to the shift indicator light.

17

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

Installation of the NCC-001 Nitrous Control Center

18

3.1.2

One Stage of Progressive Nitrous and Fuel
Use this configuration to control the one stage of progressive nitrous and fuel.
Connect the solid red wire labeled "12 VOLT PWR" to the "+12 Volt" terminal on the NCC-001 and to a fused
and switched 12 volt DC source.
Connect the solid black wires labeled "GROUND1" and "GROUND2 to the "Ground1" and "Ground2" terminals
on the NCC-001 and to the battery ground stud.
Connect the yellow wire labeled "ARMING INPUT" to the "Arming Input" terminal on the NCC-001, through a
WOT switch (alternatively, the TPS can be connected to the TPS Input), and to one of the wiring terminals on
the Nitrous Arming Switch. The Nitrous Arming Switch output should then be connected to the input of the
nitrous solenoid(s). If the combined current load of the nitrous and/or fuel solenoids exceeds the capacity of the
NCC-001, LPE recommends controlling the solenoids via relays. Depending on the current rating and quantity
of the solenoids you are using, it may be necessary to use separate relays for each of the nitrous stages. If
using relays to control the solenoids, see example wiring instructions in section 3.1.3.
Connect the striped dark brown wire labeled "N2O SLND 1" to the "N2O Solenoid1" terminal on the NCC-001
and to Nitrous Solenoid 1.
Connect the striped tan wire labeled "FUEL SLND 1" to the "Fuel Solenoid1" terminal on the NCC-001 and to
Fuel Solenoid 1.
If the user desires to activate the nitrous using engine speed, to data log the RPM, or to control a shift light,
connect the striped white wire labeled "TACH INPUT" to the "Tach Input" terminal on the NCC-001 and to a
suitable RPM Signal Source. The RPM signal source could be the tachometer output lead of the vehicle, the
switched side of the ignition coil (negative side), or the 5 volt RPM reference signal. See Appendix C: Tables
and Diagrams for the location of the tachometer output wiring on some common GM vehicles.
If the addition of a shift indicator light is desired, connect the solid green wire labeled "SHIFT LIGHT" to the
"Shift Light, +12V" terminal on the NCC-001 and to the shift indicator light.
WARNING: The fuses that are positioned in series between the 12 volt power source and the relays are
labeled as 30 amps each. It is important to note that the amperage rating for these fuses are just
suggestions and that the amount of current that your solenoids can pull will determine the correct fuses
for your system.
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3.1.3

Two Stages of Progressive Nitrous and Fuel
Use this configuration to control two stages of progressive nitrous and fuel.
Connect the solid red wire labeled "12 VOLT PWR" to the "+12 Volt" terminal on the NCC-001 and to a fused
and switched 12 volt DC source.
Connect the solid black wires labeled "GROUND1" and "GROUND2 to the "Ground1" and "Ground2" terminals
on the NCC-001 and to the battery ground stud.
Connect the yellow wire labeled "ARMING INPUT" to the "Arming Input" terminal on the NCC-001, through a
WOT switch (alternatively, the TPS can be connected to the TPS Input), and to one of the wiring terminals on
the Nitrous Arming Switch. The Nitrous Arming Switch output should then be connected to the input of the
nitrous solenoid(s). If the combined current load of the nitrous and/or fuel solenoids exceeds the capacity of the
NCC-001, LPE recommends controlling the solenoids via relays. Depending on the current rating and quantity
of the solenoids you are using, it may be necessary to use separate relays for each of the nitrous stages. If
using relays to control the solenoids, see example wiring instructions in section 3.1.3.
Connect the striped dark brown wire labeled "N2O SLND 1" to the "N2O Solenoid1" terminal on the NCC-001
and to Nitrous Solenoid 1.
Connect the striped green wire labeled "N2O SLND 2" to the "N2O Solenoid2" terminal on the NCC-001 and to
Nitrous Solenoid 2.
Connect the striped tan wire labeled "FUEL SLND 1" to the "Fuel Solenoid1" terminal on the NCC-001 and to
Fuel Solenoid 1.
Connect the striped orange wire labeled "FUEL SLND 2" to the "Fuel Solenoid2" terminal on the NCC-001 and
to Fuel Solenoid 2.
If the user desires to activate the nitrous using engine speed, to data log the RPM, or to control a shift light,
connect the striped white wire labeled "TACH INPUT" to the "Tach Input" terminal on the NCC-001 and to a
suitable RPM Signal Source. The RPM signal source could be the tachometer output lead of the vehicle, the
switched side of the ignition coil (negative side), or the 5 volt RPM reference signal. See Appendix C: Tables
and Diagrams for the location of the tachometer output wiring on some common GM vehicles.
If the addition of a shift indicator light is desired, connect the solid green wire labeled "SHIFT LIGHT" to the
"Shift Light, +12V" terminal on the NCC-001 and to the shift indicator light.
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3.1.4

NCC-001 Controlling the Solenoids Via Nitrous Solenoid Driver
Use this wiring configuration to activate the solenoids through a Solid State Solenoid Driver. Solid State Solenoid
Drivers provide faster response time and can generally handle higher current loads than standard 5-40 amp
automotive relays. While this wiring diagram only shows a single stage of nitrous control, multiple stages of
nitrous and fuel can be controlled via Solid State Solenoid Drivers by simply repeating this wiring procedure for
each nitrous and fuel solenoid.
NOTE: While the NCC-001 controls the ground-side of the solenoids, the Solid State Solenoid Driver switches the
signal and controls the +12 volt side of the solenoids.
NOTE: Because of the difference in response time between solid state relays and mechanical automotive relays,
solid state relays and mechanical automotive relays should not both be used to control solenoids in the same
circuit. The solenoids being activated through the mechanical automotive relays will react slower than the
solenoids activated through the solid state relays.
• The Solid State Solenoid Driver should recieve +12 volts from the battery through an in-line fuse.
• The activation signal from the NCC-001 that progressively controls the solenoids will be the input to the solenoid
driver.
• The output from the Solid State Solenoid Driver should go to the +12 Volt side of the solenoid to be controlled.

3.1.5

NCC-001 Controlling Nitrous Solenoids Via Relays
Use this configuration to control the nitrous solenoids using relays. If you are using nitrous solenoids that pull
high current, it is best to use a relay between the solenoid and controller to protect the controller from the current
of the nitrous solenoids.
NOTE: For better PWM performance, LPE recommends installing automotive relays that do not contain
resistors or diodes when using relays to control the solenoids.
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Connect the solid red wire labeled "12 VOLT PWR" to the "+12 Volt" terminal on the NCC-001 and to a fused
and switched 12 volt DC source.
Connect the solid black wires labeled "GROUND1" and "GROUND2 to the "Ground1" and "Ground2" terminals
on the NCC-001 and to the battery ground stud.
Connect the yellow wire labeled "ARMING INPUT" to the "Arming Input" terminal on the NCC-001, through a
WOT switch (alternatively, the TPS can be connected to the TPS Input), and to one of the wiring terminals on
the Nitrous Arming Switch. The Nitrous Arming Switch output should then be connected to the input of the
nitrous solenoid(s). If the combined current load of the nitrous and/or fuel solenoids exceeds the capacity of the
NCC-001, LPE recommends controlling the solenoids via relays. Depending on the current rating and quantity
of the solenoids you are using, it may be necessary to use separate relays for each of the nitrous stages. If
using relays to control the solenoids, see example wiring instructions in section 3.1.3.
Connect the striped dark brown wire labeled "N2O SLND 1" from pin 87 of an automotive relay to Nitrous
Solenoid 1. A wire should then be run from pin 85 of the relay to the terminal labeled "N2O Solenoid1" on the
NCC-001. Next, a wire should connect pin 86 to a fused 12 volt source, such as the battery. Finally, use a wire
to connect pin 30 on the relay to a reliable ground source.
Connect the striped green wire labeled "N2O SLND 2" from pin 87 of an automotive relay to Nitrous Solenoid 2.
A wire should then be run from pin 85 of the relay to the terminal labeled "N2O Solenoid2" on the NCC-001.
Next, a wire should connect pin 86 to a fused 12 volt source, such as the battery. Finally, use a wire to
connect pin 30 on the relay to a reliable ground source.
Connect the striped tan wire labeled "FUEL SLND 1" to the "Fuel Solenoid1" terminal on the NCC-001 and to
Fuel Solenoid 1.
Connect the striped orange wire labeled "FUEL SLND 2" to the "Fuel Solenoid2" terminal on the NCC-001 and
to Fuel Solenoid 2.
If the user desires to activate the nitrous using engine speed, to data log the RPM, or to control a shift light,
connect the striped white wire labeled "TACH INPUT" to the "Tach Input" terminal on the NCC-001 and to a
suitable RPM Signal Source. The RPM signal source could be the tachometer output lead of the vehicle, the
switched side of the ignition coil (negative side), or the 5 volt RPM reference signal. See Appendix C: Tables
and Diagrams for the location of the tachometer output wiring on some common GM vehicles.
If the addition of a shift indicator light is desired, connect the solid green wire labeled "SHIFT LIGHT" to the
"Shift Light, +12V" terminal on the NCC-001 and to the shift indicator light.

Installation of the NCC-001 Nitrous Control Center
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3.1.6

NCC-001 Controlling a Bottle Heater
Use this diagram to provide programmable closed loop bottle heater control using the nitrous pressure sensor.
NOTE: Each terminal on the NCC-001 controller is capable of connecting to 2 separate wires at a time. If there
are more than two wires going to a single terminal (as may be the case with the sensor ground terminal), splice
the incoming wires together. Another option is to purchase a barrier strip adapter that increases the wire capacity
of the single terminal.
WARNING: If the nitrous pressure sensor is located on the tank side of your nitrous bottle valve, the
valve can be closed between runs as the sensor can still sense the bottle pressure while it is being
heated. If your nitrous pressure sensor is located on the outgoing side of your valve, the valve must
stay open anytime the bottle is being heated so that the nitrous pressure sensor can regulate the
pressure. Heating the bottle with the pressure sensor on the outgoing side of the valve and the valve
shut could potentially cause an extremely dangerous over-pressure condition. Per NHRA rules, the
bottle's over-pressure safety disk should be connected to a blow down tube that allows nitrous to be
vented out of the vehicle in the event that the safety disk ruptures. Before using the nitrous bottle(s),
make sure that they are properly secured to the vehicle. If using a bottle heater, make sure that the
bottle heater is properly secured to the bottle and that it lays completely flat around the bottle.

Connect the solid red wire labeled "12 VOLT PWR" to the "+12 Volt" terminal on the NCC-001 and to a fused
and switched 12 volt DC source.
Connect the solid black wires labeled "GROUND1" and "GROUND2 to the "Ground1" and "Ground2" terminals
on the NCC-001 and to the battery ground stud.
Connect the solid orange wire labeled "RELAY2 12V" to the "Relay2 Out, +12V" terminal on the NCC-001 and
to the bottle heater relay input.
Connect the output of the relay to the input for the bottle heater. Make sure to follow the bottle heater
manufacturer's instructions.
Using the Nitrous Pressure Sensor Harness, connect the nitrous pressure sensor harness connector to the
nitrous pressure sensor. Then, connect the solid white wire labeled "NITROUS" to the "N2O PSI Input" terminal
on the NCC-001, the solid red +5 volt wire to the "Sensor +5V" terminal on the NCC-001, and the solid black
ground wire to the "Sensor GND" terminal on the NCC-001.
A temperature switch can also be added for additional protection.
Program the Relay2 Out for nitrous pressure control.

Installation of the NCC-001 Nitrous Control Center
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3.1.7

NCC-001 Connected to the LPE LNC-2000 Launch Controller
Use this wiring configuration to allow the NCC-001 to output a progressive signal to the LPE LNC-2000 Launch
Control Module. This collaboration between the controllers creates progressive spark retard. The optional LNC2000 then can send spark data back to the NCC-001 where the data is logged. See the LNC-2000 instructions for
more information regarding the wiring and settings of the LNC-2000.
NOTE: The female connector that is used to connect the NCC-001 to the LNC-2000, as shown in the
wiring diagram below, is not necessary in order to connect the NCC-001 to the LNC-2000. LPE is
currently developing an adapter harness that will allow the analog out signal from the NCC-001 to reach
the analog input on the LNC-2000 without the need to modify the wiring. Until that adapter harness is
released, the LNC-2000 Analog Out wire (purple) should be taken out of the male harness connector and
connected to the NCC-001 as described in the instructions below.
NOTE: Each terminal on the NCC-001 controller is capable of connecting to 2 separate wires at a time.
If there are more than two wires going to a single terminal (as may be the case with the sensor ground
terminal), splice the incoming wires together. Another option is to purchase a barrier strip adapter that
allows the single terminal to connected to another barrier strip for increased capacity.
1) If connecting the LNC-2000 to the NCC-001 without an adapter:
Extract the purple wire from the LNC-2000 male harness connector.
Splice the solid purple wire (LNC-2000 Analog input) from the LNC-2000 with the solid purple wire labeled
"ANALOG OUT" supplied in the NCC-001 wiring harness. Connect the spliced purple wire to the "Analog Out"
terminal on the NCC-001 controller
Optional: To log timing retard, connect the solid gray wire (Analog Out) from the LNC-2000 to the "Analog1
Input" terminal on the NCC-001
2) If installing the LPE female harness connector:
Connect the solid purple wire (Analog Out) from the NCC-001 harness to the B (middle) terminal on the female
harness connector.
Connect the female harness connector to the orange LNC-2000 MAP sensor male connector.
Optional: To log timing retard, connect the solid gray wire (Analog Out) from the LNC-2000 to the "Analog1
Input" terminal on the NCC-001

Installation of the NCC-001 Nitrous Control Center
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3.1.8

NCC-001 Connected to the LNC-2000 for Simple On/Off Control
Use this configuration to allow the NCC-001 to activate or deactivate the LNC-2000 Launch Control Module
via +12V relay output. In this configuration, the NCC-001 would act as an activation switch for the LNC-2000,
providing the +12V activation for the LNC-2000. The settings on the LNC-2000 would create the timing retard ramp.
See the LNC-2000 instructions for more information regarding the wiring and settings of the LNC-2000.
To connect the NCC-001 to the LNC-2000 in this configuration:
On one end of the orange wire labeled "RELAY2 12V", crimp a terminal and connect the wire to the Relay2 Out
terminal on the NCC-001.
Connect the other end of the orange wire labeled "RELAY2 12V" to the orange +12V Retard Activation wire from
the LNC-2000.
Select the enabling criteria for the Relay2 Output on the NCC-001.
Optional: To log timing retard, connect the solid gray wire (Analog Out) from the LNC-2000 to the Analog1 Input
terminal on the NCC-001.

3.1.9

NCC-001 Connected to the Pin on the ECM for EFILive Nitrous Operating System and
Fuel Control
This configuration allows the NCC-001 to activate the E85/Nitrous feature of the EFILive custom operating system
on E38 and E67 Electronic Control Modules (ECM). This allows the production ECM to control the additional fuel
needed for nitrous and to modify the ignition timing based on nitrous activation.
The +12 volt output from Relay 2 is connected to the ECM and the Relay 2 output is activated when nitrous is
activated, allowing you to target a different air-fuel ratio (AFR) and ignition timing when Relay 2 is commanded ON.
This can be used to provide the fuel for the primary stage of nitrous or for a secondary stage of nitrous. When
used as the fuel supply for the nitrous, this eliminates the need for a separate fuel supply system, fuel solenoid(s),
and fuel nozzle(s). It also eliminates problems of fuel distribution that can occur with plate-style fuel supply
systems in intake manifolds not normally designed to distribute fuel.
NOTE: The wire colors and pin positions in the wiring diagrams below are for GM vehicles equipped
with E38/E67 ECM's ONLY. Identify the wires and pins positions of your vehicle's ECM and confirm their
individual functions before beginning the modification below.
Locate and unlock the ECM connector 1 on both the E38 and E67 ECM's. Pull the lever away from the lock to
remove ECM connector 1 from the ECM.
Expose the wiring going into the connector by disengaging the two (2) tabs on either side of the connector.
Locate pin 5 on E38 ECM connector 1 (black) or pin 2 on E67 ECM connector 1 (blue). The location of pin 5 for
the E38 ECM is shown by the connector end view in the following wiring diagram.
Using an electrical connector pin removal tool (or equivalent), push on the plug that seals the connector. It
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should not take much pressure for the plug to fall out.
Using an electrical connector pin removal tool (or equivalent), remove the black terminal separator. This can be
done by gently prying on either end of the black terminal separator, the part of the connector that is inserted into
the ECM.
If the plug is still in the pin position, remove it using an electrical connector pin removal tool (or equivalent).
Using a crimping tool, crimp a terminal (PN: DK321288) to the end of the solid orange wire labeled "RELAY2
12V". This end of the wire will be inserted into the pin position on the connector.
Insert the crimped terminal into the back of the connector. The connector MUST be oriented the right way so
that the open part of the wire slides into a locking tang inside the connector.
NOTE: You should here a "click" when the wire terminal engages the locking tang. If no audible click is heard,
the locking tang is not fully engaged.
Re-install the black terminal separator onto the connector by lining the separator up to the correct terminals on
the connector and pressing down until fully engaged.
Re-engage the tab on both sides of the connector to re-install the wire enclosure on the back of the connector.
Plug the connector back into the ECM and push the lever towards the connector to engage the locking
mechanism.
Connect the other end of the solid orange wire labeled "RELAY2 12V" to the "Relay2 Out, +12V" terminal on the
NCC-001.
Program Relay2 Out based on Nitrous1 or Nitrous2 activation.

NOTE: for additional instructions and pictures of the installation described above, go to Installing the
EFILive E38 / E67 ECM Ethanol Custom Operating System for the installation instructions written by
EFILive.

Installation of the NCC-001 Nitrous Control Center
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3.1.10 Connecting the NCC-001 to Throttle Position Sensors on Mechanical and Electrical
Throttle Vehicles
The NCC-001 is able to be connected to the Original Equipment Manufacturer (OEM) Throttle Position Sensor
(TPS) signal on both mechanical and electronic throttle vehicles. The NCC-001 can also be connected to the
Accelerator Pedal Position (APP) signal on most electronic throttle vehicles. The NCC-001 can be connected to a
rising or falling 5 volt signal. On most electronic throttles, both a rising and falling signal exists, and the TPS
Setup Menu allows you to program the NCC-001 accordingly.
On electronic throttle applications, LPE generally recommends connecting to the rising voltage signal on the
throttle. One reason for using the TPS signal instead of the APP signal is that the throttle can be at a different
angle than what the APP is requesting. As an example, during a full throttle shift, the throttle may close despite
the accelerator pedal being fully applied.
In some applications, you may want to install a separate TPS to be connected to the NCC-001.
WARNING: It is very important to maintain the proper sensor signals to the ECM in electronic throttle
(also known as "Drive by wire") applications. The ECM closely monitors these signals for safety reasons.
Improper wiring could result in a reduced engine power condition, diagnostic codes, or even loss of
vehicle control.
NOTE: The wire colors and pin positions in the wiring diagrams below may differ from the wiring in
your vehicle. Identify the wires of the throttle body sensor harness in your vehicle and confirm their
individual functions before beginning one of the modifications below.
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Obtaining the TPS signal on a vehicle equipped with a mechanical throttle body:
Locate the Throttle Position Sensor (TPS).
Disconnect the TPS harness from the TPS and remove the loom from the harness.
Locate the TPS signal wire. This is the wire that communicates the throttle position to the PCM.
Splice a wire onto the TPS signal wire.
Use the labeled wire from the NCC-001 wiring harness or crimp a terminal to the other end of the wire that was
spliced into the TPS signal wire in the last step.
Insert the terminal end of the wire into the "TPS Input" terminal on the NCC-001.
Re-install the loom back onto the harness
Re-connect the TPS harness to the TPS.
Program the TPS Input on the NCC-001 controller.

Installation of the NCC-001 Nitrous Control Center
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Obtaining the TPS signal on a vehicle equipped with an electronic throttle body:
Locate the Throttle Position Sensor (TPS) to the TPS/motor connector.
Disconnect the TPS harness from the TPS or throttle and remove the loom from the harness.
Locate the TPS signal wire 1. This is one of the two wires that relay the throttle position signal to the ECM.
Splice a wire onto the TPS signal wire.
Use the labeled wire from the NCC-001 wiring harness or crimp a terminal to the other end of the wire that was
spliced into the TPS signal wire 1 in the last step.
Insert the terminal end of the wire into the "TPS Input" terminal on the NCC-001.
Re-install the loom back onto the harness
Re-connect the TPS harness to the TPS.
Program the TPS Input on the NCC-001 controller.
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3.1.11 NCC-001 Connected to the Clutch Position Sensor
Use this configuration to enable or disable the nitrous through the NCC-001 by the position of the clutch pedal. By
connecting the clutch pedal position (CPP) sensor to the Analog1 input on the NCC-001, the controller will either
enable or disable nitrous based on the position of the clutch pedal. Refer to Analog1 Setup Menu for more
information on the clutch option.
With the arming switch enabled and the vehicle at the line, depressing the clutch pedal disables the nitrous, even
though the throttle may be above the TPS enable percentage. When the clutch is released, the system is
enabled and nitrous can flow. During each gear change, the nitrous will be disabled until the clutch is released
again.
NOTE: The wire colors and pin positions in the wiring diagrams below may differ from the wiring in
your vehicle. Identify the wires of the clutch position sensor harness in your vehicle and confirm their
individual functions before beginning one of the modifications below.
NOTE: The clutch position sensor and clutch position switch inputs can be used at the same time,
allowing the Clutch Input to be used for Line-lock.
Obtaining the CPP sensor signal on a vehicle equipped with a clutch pedal position sensor:
Locate the Clutch Pedal Position Sensor (CPP). This sensor is generally mounted to the clutch pedal
assembly.
Remove the loom on ECM Connector.
Locate the CPP signal wire. This is the wire that communicates the clutch position to the ECM.
Splice a wire onto the CPP signal wire.
Use the labeled wire from the NCC-001 wiring harness or crimp a terminal to the other end of the wire that was
spliced into the CPP signal wire in the last step.
Insert the crimped end of the wire into the "Analog1 Input" terminal on the NCC-001.
Re-install the loom back onto the ECM connector harness.
Program Analog1 for clutch input.

Installation of the NCC-001 Nitrous Control Center
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3.1.12 NCC-001 Connected to the Clutch Position Switch
Use this configuration to connect the NCC-001 to a Clutch Pedal Position Switch, line-lock, or trans-brake. The
Clutch pedal position switch will be connected to the "Clutch Input" terminal on the NCC-001.
The Clutch Input to the NCC-001 needs to be an open circuit when the clutch is released and either a ground
or +12 volt signal when the clutch is engaged (clutch pedal depressed). The +12 volt or ground activation input
must be configured through the input polarity options menu on the NCC-001 controller.
With the arming switch enabled and the vehicle at the line, depressing the clutch pedal disables the nitrous, even
though the throttle may be above the TPS enable percentage. When the clutch is released, the system is
enabled and nitrous can flow. During each gear change, the nitrous will be disabled until the clutch is released
again.
On the 1998-2002 Camaro and Firebird (F-Body) and 1997-2008 Corvette clutch switch, a relay must be added to
the circuit to convert the cranking switch position voltage to ignition switched voltage. The use of a relay, as
shown in the wiring diagram below, is necessary due to the fact that the clutch pedal position switch is only
powered during vehicle start-up. When connecting to the clutch switch, be sure to use the clutch switch at the
bottom of the travel. This is the one tied to the static system. Do not use the one at the top of the travel, which is
the cruise control disable switch. This switch tends to send erratic signals.
NOTE: The wire colors and pin positions in the wiring diagrams below may differ from the wiring in
your vehicle. Identify the wires of the clutch pedal position switch in your vehicle and confirm their
individual functions before beginning the modification below.
Locate the clutch pedal position switch and unplug the two-wire connector.
Cut the wires approximately three inches back from the connector
Locate a +12 volt key-on power source and connect the source to the clutch pedal position switch power wire.
Use the labeled wire from the NCC-001 wiring harness or crimp a terminal to the one end of the wire for the
following step.
Splice two wires onto the remaining connector wire. One of these wires will go to the "Clutch Input" terminal on
the NCC-001 controller while the other wire will be going to pin 85 of a standard automotive relay.
Program the Clutch Input Polarity on the NCC-001 controller.
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3.1.13 Converting a CPP Sensor Signal Into a 12 Volt signal via Conversion Module
Use this configuration if you want the Clutch Input to come from a Clutch Pedal Position (CPP) Sensor. This
configuration allows the clutch position signal to be sent to the Clutch Input on the NCC-001, allowing the Analog1
input feature to be connected to other sensors. This configuration is intended for vehicles equipped with clutch
pedal position sensors ONLY. While the clutch pedal position switch puts out a switched 12 volt signal when a
certain clutch pedal position is reached, the clutch pedal position sensor puts out a signal that ranges anywhere
between 0-5 volts depending on the position of the pedal. Because of this, the signal from the clutch pedal
position switch can be sent directly to the Clutch Input on the NCC-001, but the signal from the clutch pedal
position sensor cannot. You can either connect the CPP sensor to the Analog1 Input or use a conversion module
to connect it to the Clutch Input. In order to use the signal from the clutch pedal position sensor to activate the
clutch input, the 0-5 volt signal from the sensor has to be converted into the switched 12 volt signal that the Clutch
Input on the NCC-001 is looking for. This conversion can be accomplished through the use of a Clutch/TPS switch
signal conversion module. The Clutch/TPS switch signal conversion module receives the 0-5 volt signal from the
clutch pedal position sensor and puts out a 0 or 12 volt signal to disable or enable the clutch input on the NCC001.
NOTE: While the conversion module that LPE used for this function is no longer available, a new
version is currently in development. There are other manufacturers who are currently producing this
type of conversion module.
Locate the Clutch Pedal Position sensor (CPP). This sensor is usually mounted on the clutch pedal assembly.
Remove the loom from the wires and locate the +5 volt signal wire that connects the CPP to the ECM.
Mount the Clutch/TPS switch signal conversion module to the vehicle.
Splice the +5 volt signal input wire from the Clutch/TPS switch signal conversion module to the +5 volt CPP
signal wire from the CCP.
Connect the Clutch/TPS switch signal conversion module ground wire to a reliable ground source.
Connect the Clutch/TPS switch signal conversion module +12 volt power wire to a fused +12 volt power source
Connect the Clutch/TPS switch signal conversion module +12 volt output wire to the "Clutch Input" terminal on
the NCC-001 Controller.
Program the conversion module per the manufacturer's specifications.
Program the Clutch Input Polarity on the NCC-001 controller.
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3.2

Installation of the NCC-001 Software and Firmware
The following sub-sections detail the installation of the NCC-001 PC software required to communicate with the
controller, as well as to keep the controller up to date. The program "Nitrous Control Center" allows the user to
view data logs, transfer programs to and from the controller, and to create new programs on the computer. The
program "NCC Controller Flash Utility" is used to flash updated firmware to the controller. The controller can be
connected via USB cable to any computer equipped with Windows XP, Windows Vista, or Windows 7. The
current installed software version (or build) number can be viewed through the "About NCC-001" selection on both
the computer program or controller. The first number represents the current major revision number and the last
two numbers represent the current minor revision number.

IMPORTANT: The computer software and the controller firmware do not have to have
to be on the same minor revision number for the controller to operate, but the major
revision number MUST be the same on both or else the computer and controller will
not be able to communicate with each other. This manual was written using version
2.0.7.
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3.2.1

Installing the NCC-001 Software
The following steps are for the installation of the Nitrous Control Center program. This program allows
for the transfer of data and settings between the computer and the controller via a USB cable.

After extracting the NCC-001 software from the LPE-supplied media or downloading the software from the LPE
website, save the compressed ZIP file to your computer (the file was saved to the desktop in the illustration below)
and open the file by double-clicking on the icon.

Using a Zip file utility, such as WinZip, unzip the compressed file.

Most windows Zip-file utilities will display a dialog box explaining the risk of opening a .msi file. Click "Yes" on the
right side of the dialog box.

Installation of the NCC-001 Nitrous Control Center
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The welcome screen for the Nitrous Control Center Setup Wizard should appear at this time. Click the "Next"
button to continue on to installation. Click the "Cancel" button to abort the installation.
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The next screen prompts the user to select a folder to install the NCC-001 software to. In most cases the default
location, which is in the program files folder on the C:\ drive, should be sufficient. Click the "Browse" button to
select a different location for the software if desired. Click the "Disk Cost" button to display the available disk
space on each of the computer's available disk drives, as well as how much dick space will be left on each disk
drive if the Nitrous Control Center software is installed. LPE recommends clicking the "Disk Cost" button to verify
that there is enough disk space available on the desired drive for installation. The software, at this time, requires
roughly 3000 KB of space.
The final option in this dialog box is whether the software is to be installed for all users of the computer, or just the
user who installs it. If the user is not sure whether other users will need to use the software, toggle "Everyone" so
that other users can use the software if needed. Toggle "Everyone" or "Just me" and click "Next" to move on.

Installation of the NCC-001 Nitrous Control Center
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The installation confirmation dialog box will appear next. Click "Next" to begin installation of the NCC-001
software. The "back" button is available if it is necessary to go back to a previous dialog box to change a setting.
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The "Installation Complete" dialog box should appear after a short period of time. Click the "Close" button to exit
the installation wizard.

An icon named "Nitrous Control Center" should now appear on the desktop. Double-click on the icon to launch
the program.

Installation of the NCC-001 Nitrous Control Center
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The NCC-001 program should open to the main screen, as shown below.

Installation of the Nitrous Control Center software is now complete. To install an update to the NCC-001
software, uninstall the software and repeat the same steps to install the new NCC-001 software.
NOTE: Before updating the Nitrous Control Center software, locate the directory folder where your user
program files and data logs are saved to verify that they are not located in the Nitrous Control Center
program file folder on your C: drive. When updating the software, any files located in the Nitrous
Control Center software program file will be erased when the program is uninstalled. The default
location that the software will save to is C:/My Documents/Nitrous Control Center/User Program. If you
choose to save your user program files and data logs in a different location, make sure that you are not
saving in the Nitrous Control Center program file.
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3.2.2

Installing the NCC-001 Firmware
The following steps are for the installation of the NCC-001 Controller FLASH Utility onto a Windowsbased PC. This utility is used to flash updated embedded firmware to the controller itself. It is vital that
this utility be used because the NCC-001 controller can only interact with the computer interface if the
controller's major software build number matches that of the NCC-001 PC program.

After extracting the NCC Firmware update from the LPE-supplied media or downloading the firmware from the LPE
website, double-click on the "NCC Update" icon

The welcome screen for the NCC Controller FLASH Utility Setup Wizard should appear at this time. Click the
"Next" button to continue on to installation. Click the "Cancel" button to abort the installation.

Installation of the NCC-001 Nitrous Control Center
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The next screen prompts the user to select a folder to install the NCC Controller FLASH Utility software to. In
most cases the default location, which is in the program files folder on the C:\ drive, should be sufficient. Click the
"Browse" button to select a different location for the software if desired. Click the "Disk Cost" button to display
the available disk space on each of the computer's available disk drives.
The final option in this dialog box is whether the software is to be installed for all users of the computer, or just the
user who installs it. If the user is not sure whether other users will need to use the software, toggle "Everyone" so
that other users can use the software if needed. Toggle "Everyone" or "Just me" and click "Next" to move on.
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The installation confirmation dialog box will appear next. Click "Next" to begin installation of the NCC Controller
FLASH Utility software. The "back" button is available if it is necessary to go back to a previous dialog box to
change a setting.

Installation of the NCC-001 Nitrous Control Center
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The "Installation Complete" dialog box should appear after a short period of time. Click the "Close" button to exit
the installation wizard.

An icon named "NCC Controller FLASH Utility" should now appear on the desktop. Double-click on the icon to
launch the program.
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The Main screen of the NCC Controller FLASH Utility should appear. If the Controller is powered ON and is
connected to the computer via USB cable, the information inside the "Nitrous Control Center USB Connection
Status" dialog box should be filled out, as shown below. If the controller is powered OFF and/or the controller is
not connected to the computer, all of the outputs inside of the "Nitrous Control Center USB Connection Status",
as well as the "USB Connected" button, will be left blank.

Installation of the NCC-001 Nitrous Control Center
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To update the Controller's firmware, click on the "Update NCC" in the menu bar and click on "Update NCC Flash
Image with Backup"

Before the firmware installation can begin, the "Update Software" option found in the Global Menu must be
selected on the Controller in order for the installation can continue. An error message will appear if the controller
is not in update mode.
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The program will ask you to confirm that you want to update the Controller software. Click yes to continue on to
installation.

As the flashing of data between the computer and the controller takes place, a series of addresses should appear
in the write address dialog box of the Update Status window. During this time, the NCC FLASH utility is reading
the flash data from the controller and saving a backup in case the flash that will be sent to the controller in the
next step is corrupt.

Once the computer has read the flashed data from the NCC-001 controller, the program will ask for the location of
the firmware update that is to be installed onto the controller. Locate the directory where the .NCC file is saved,
which may be the LPE-supplied media or the directory to which the program was downloaded from the LPE
website. The picture below shows the .NCC file located on the desktop. Click on the file and click the "Open"
button to confirm your selection.

Installation of the NCC-001 Nitrous Control Center
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The NCC Controller FLASH Utility will now flash the firmware update to the controller. The dialog box below shows
that installation of the new firmware is complete, as well as the location of the backed-up firmware on the
computer. Click "OK" to continue.

The final dialog box lets the user know that the controller will reset to finish the installation of the new firmware.
Click "OK" to continue.

Installation of the firmware for the NCC-001 is now complete.
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Getting to Know the User Interface
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4

Getting to Know the User Interface
This chapter will introduce the buttons and display on the NCC-001, as well as NCC computer interface. The
display may slightly change depending on what options have been enabled on the controller. For example the
Analog 1 input that is displayed on the screen as "AN1= 0.00" will change to "CLU= 0.00" if the Analog 1 Input
clutch option is enabled.

4.1

The NCC-001 Controller Interface
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4.2

The "Main" And "Settings" Screen
Main Screen on the NCC-001

Setting Screens on the NCC-001

Getting to Know the User Interface
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4.3

The Computer Interface Status Screen
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5

Global Menu / Setup-Options
The Global Menu of the NCC-001 Nitrous Control Center is where all of the global settings are located. The global
settings are the settings that apply to all three user-defined programs. The Global menu can be accessed from
the Main Screen by pressing the far left navigation button on the controller. The following sub-sections detail the
location and function of each setting in the Global Menu.

5.1

Current Program
There are 3 user-defined data setups available. All user settings will be saved when selecting a new data setup
from the list. This way multiple user setups can be stored and recalled at a later time. Example - you have a setup
that is working well, but you would like to try a few different settings. You could then select and copy all current
setup data to a new setup and make changes without losing the original setup.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “ENTER” button to select the Current Program
menu. Using the “UP” and “DOWN” arrow buttons select the desired setup and press “ENTER”. You will then be
prompted to copy the current program to the new setup selected. If you choose “YES” the current setup will be
copied to the new setup selected.
NOTE—When asked to make a selection from a “Message Box” the default selection will be chosen after 20
seconds.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The current program is found in the "Program" dialog box
under the "Options" Tab. Click on the desired program from the pull down menu.
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5.2

Copy Current Program
The current program may be copied to another program after selecting to which program the current user data is to
be copied. If the current program is selected, the request will be ignored.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “ENTER” button to select the Copy Current
Program menu. Using the “UP” and “DOWN” arrow buttons select the desired setup to copy the current program
to and press “ENTER”. Press "YES" to copy the current program or "NO" to abort the operation.
NOTE—When asked to make a selection from a “Message Box” the default selection will be chosen after 20
seconds.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The copy current program option is found in the "Program"
dialog box under the "Options" Tab. Select the desired setup to copy the current program to from the pull-down
menu and click the "COPY" button. Click "YES" to copy the current program or "NO" to abort the operation.

5.3

Hold & Wait
This setting allows the progressive system to Hold & Wait when one of the activation criteria are removed.
Example - the throttle is lifted due to wheel spin. The Hold & Wait feature allows the progressive system to
resume at the point where the throttle was lifted. Resume settings can be used to create a resume ramp. If the
Hold & Wait option is disabled and the throttle is lifted, the nitrous and fuel flows will start over at the beginning of
the progressive ramp, along with any applicable cycle start delays. The inputs that will activate the Hold & Wait
feature are:
Arming Input
Clutch Input
Clutch sensor (Analog1) - If enabled
TPS Input - If enabled

Global Menu / Setup-Options
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NOTE—If this option is "OFF" the progressive system and all timers will reset each time any of the arming criteria
are removed.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Hold &
Wait" menu selection is highlighted and then press the “ENTER” button. Press the “YES” or “NO” button to
change the current selection. If the “NO” button is pressed, no change will be made.
NOTE—When asked to make a selection from a “Message Box” the default selection will be chosen after 20
seconds.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Hold & Wait" option is found in the "Nitrous Timer
Options" dialog box under the "Options" Tab. Click "ON" to enable the Hold & Wait feature or "OFF" to disable
the feature.

5.4

Main Timer
This setting controls the main timeout period in seconds. This controls the total time elapsed before a system
timeout occurs. The Main Timer acts as a safety feature by limiting the total amount of time the solenoids can be
on once the system is activated.
When the Hold & Wait option is selected, the timer will continue to count down, even after the activation criteria
have been removed. When the Hold & Wait option is not selected and the activation criteria have been removed,
the Main timer will reset and start over when the activation criteria are again met.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the "Main
Timer" menu selection is highlighted and then press the “ENTER” button. Using the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.
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Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Main Timer" setting is found in the "Nitrous Timer
Options" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value from 20-300.

5.5

Fuel Trim Option
WARNING - This setting controls the Fuel Trim. This setting allows the Fuel Percentage to be set to Less
than the Nitrous percentage. Use this setting with great caution!
This setting controls the total Percentage the Fuel may be set less than the Nitrous percentage. Example—a
setting of 25 would allow the Fuel percent to be 25% less than the Nitrous percentage. A fuel trim setting of 0%
does not allow the fuel to be less than the nitrous in the stage1 or stage2 graphs.
Valid Range is 0% to 100% in 0.1% increments.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Fuel
Trim Option" menu selection is highlighted and then press the “ENTER” button. Using the “LEFT” and ”RIGHT”
arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Fuel Trim" setting is found in the "Fuel Solenoid Control
Option" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value from 0.0-100.0.

Global Menu / Setup-Options
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See Appendix B: Nitrous & Fuel Operation for more information.

5.6

Set Input Polarity
The Input Polarity for the Arming, Clutch, and Shift inputs may be configured for either ground or +12V Arming.
This allows the controller to be configured to work with existing wiring or to eliminate the need for relays to change
the Arming polarity. The current input polarity state is displayed and will be updated when changed. This setting
is global, so it will remain the same regardless of which program you are currently using.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Set
Input Polarity" menu selection is highlighted and then press the “ENTER” button. Using the “LEFT” and ”RIGHT”
arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Input Polarity" settings is found in the "Input Polarity"
dialog box under the "Options" Tab. Click either the "Ground" or "+12 Volt" button to select the input polarity of
each input.

5.7

Pulses Per Degrees
This setting determines the number of tachometer pulses per revolution of the crankshaft. The following list shows
the available settings for this input. Refer to Appendix C: Tables and Diagrams for a table of recommended RPM
pulse counts for different applications.
1 pulse per 720 degrees (or 0.5 pulse per 360 degrees)
1 pulse per 360 degrees
2 pulses per 360 degrees
3 pulses per 360 degrees
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4 pulses per 360 degrees
5 pulses per 360 degrees
6 pulses per 360 degrees
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Pulses
Per Degrees" menu selection is highlighted and then press the “ENTER” button. Use the “UP” and ”DOWN” arrow
buttons to adjust the setting. Press the “ENTER” button to accept the new setting or press the “BACK” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Tachometer Pulse Frequency" setting is found in the
"Tachometer Input Pulse Frequency" dialog box under the "Options" Tab. Click on one of the settings in the
scroll-down menu to select the desired pulses per degree setting.

5.8

Tachometer Pull-Up
This setting enables or disables a 4.7k Ohm pull-up resistor to +12v on the Tach Input terminal. This option is
normally used when connecting to the engine speed signal output from an ECM that is not connected to any other
systems or modules in the vehicle. On vehicles that already have this signal connected, a Pull-Up resistor is
normally already in the circuit. You DO NOT want to have multiple Pull-Up resistors in the circuit. Vehicles that
have a Pull-Up resistor in the instrument cluster (such as the C5 and C6 Corvettes) will want to disable this feature
because it will create too much resistance. Vehicles that do not have a pull-up resistor in the instrument panel
(such as the 2010-2013 Camaros and 2007-2012 CK trucks) will want to enable this feature.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Tach
Pull-Up" menu selection is highlighted and then press the “ENTER” button. Press the “YES” or “NO” button to
change the current selection. If the “NO” button is pressed, no change will be made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Tachometer Pull-Up" option is found in the "Tachometer
Global Menu / Setup-Options
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Input Pull-Up Resistor Enable" dialog box under the "Options" Tab. Click "ON" to enable the Tachometer Pull-Up
Resistor feature or "NO" to disable the feature.

5.9

Help Option
Use this setting to turn the Automatic Help feature ON/OFF. When this feature is ON you will be prompted to view
Help text for each setting when you are making Menu selections.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Help"
menu selection is highlighted and then press the “ENTER” button. Press the “YES” or “NO” button to change the
current selection. If the “NO” button is pressed no change will be made.
NOTE - When asked to make a selection from a “Message Box” the default selection will be chosen after 20
seconds.

NOTE - When the Automatic Help feature is ON, there is an option on the help prompt screen that allows the user
to disable the feature without going back to the Help Option in the Global menu. When the help prompt screen
appears, as shown below, press the "OFF" button to disable the Automatic Help feature.

5.10

Factory Reset
Selecting this option will return ALL Settings to the original Factory settings. This option is only available through
the NCC-001 controller.
Access from the Controller:
From the Main screen, press the “Global” button. press the “DOWN” arrow button repeatedly until the "Factory
Reset" menu selection is highlighted and then press the “ENTER” button. Press the “YES”, “NO”, or “CANCEL”
button to change the current selection. If the “NO” or “CANCEL” button is pressed no change will be made.
NOTE—When asked to make a selection from a “Message Box” the default selection will be chosen after 20
seconds.
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5.11

Update Software
Selecting this option will force the controller to enter update mode. You may exit update mode and return to
normal operation if a valid software image is present. This option is only available through the NCC-001 controller.
You MUST have a PC/laptop equipped with a USB port and the proper software installed to update the controller
software image.
Access from the Controller:
From the Main screen, press the “Global” button. Press the “DOWN” arrow button repeatedly until the "Update
Software" menu selection is highlighted and then press the “ENTER” button. Press the “YES”, “NO”, or “CANCEL”
button to change the current selection. If the “NO” or “CANCEL” button is pressed no change will be made.

5.12

Display Contrast
Use this Setting to adjust the LCD Display contrast. This setting is only available on the NCC-001 controller.
Access from the Controller:
From the Main screen, press the “GLOBAL” button. Press the “DOWN” arrow button repeatedly until the "Display
Contrast" menu selection is highlighted and then press the “ENTER” button. Using the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

5.13

About NCC-001
This selection displays the current firmware version and the software build date.
Access from the Controller:
Global Menu / Setup-Options
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From the Main screen press the “GLOBAL” button, press the “DOWN” arrow button repeatedly until the "About"
menu selection is highlighted and then press the “ENTER” button. Press the “BACK” button to exit.

Access from the Computer Program:
From the Status screen, click on the "Help" button in the top toolbar. The current software version will be
displayed at the bottom of the menu.
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Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
The following options and settings can be found in either the Nitrous1 (N2O-1) or Nitrous2 (N2O-2) menus. The
Nitrous1 menu holds the options and settings for the first stage of nitrous while the Nitrous2 menu holds the
options and settings for the second stage. For the sake of simplicity, the illustrations in this chapter will show
only the Nitrous1 menu, but note that the Nitrous1 and Nitrous2 menus have the exact same options and settings
—they just control different nitrous stages.

6.1

Nitrous Delay
This setting determines the amount of delay before the respective nitrous stage begins after being activated. The
delay applies to the entire stage, which includes nitrous and fuel. A Fuel Advance can also be used so that the
fuel may be started before the nitrous if desired.
The Valid Range is 0.000 to 9.990 seconds in .001 second increments.
Access from the Controller:
From the Main screen press the “NITROUS” button, and then press the “ENTER” button. Using the “LEFT” and
”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC”
button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
Nitrous Delay Setting is found in the "Nitrous Stage Delay" dialog box under the "Options" tab. Click the "UP"
button, "DOWN" button, or enter a numerical value up to 9.990 to set the nitrous delay.

See Appendix B: Nitrous & Fuel Operation for more information.

69

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

6.2

Nitrous Quick Setup
Quick Setup
Use this selection to do Quick Progressive setups. This feature allows the Nitrous to be setup using a Start
Percent, Final Percent, and a Build Time. For advanced Nitrous and Fuel ramps use the Nitrous Graph Setup and
the Fuel Graph Setup menu selections.
NOTE—This selection is provided so that Quick and Easy Nitrous Power Ramps can be created. This selection
has limited user adjustment of the power ramp and fuel delivery. Also, Quick Setup will make the fuel graph the
same as the nitrous graph. Please see the Nitrous Graph Setup and Fuel Graph Setup menu selections for
advanced control.
Access from the Controller:
From the Main screen, select the stage by pressing the “N2O-1” button or the "N2O-2" button. Press the “DOWN”
arrow button repeatedly until the "Nitrous Quick Setup" menu selection is highlighted and then press the “ENTER”
button. Using the “UP” and ”DOWN” arrow buttons, select the setting to be changed and hit "ENTER". Adjust the
setting and press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.

After all settings have been determined press the “BACK” button, press the “YES” button to accept the New
Nitrous Power Ramp settings or “NO” to exit without saving the new settings.
When a New Nitrous Power Ramp is saved, the Nitrous and Fuel Tables are updated with the Quick Setup Data.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous Quick Setup" options are found in the "Nitrous Quick Setup" dialog box under the "Nitrous Graph" Tab.
Click the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown in the different
settings below. Press the "APPLY" button to confirm the changes.

Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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Start Percent
This setting determines the Nitrous Starting percentage. The Start Percent can be less than or greater than the
Final Percent setting. If the Start percent is greater than the Final percent the ramp will progress backwards.
The Valid Range is 0% to 100% in 1% increments.

Access from the Controller:
From the Main screen, select the stage by pressing the “N2O-1” button or the "N2O-2" button. Press the “DOWN”
arrow button repeatedly until the "Nitrous Quick Setup" menu selection is highlighted and then press the “ENTER”
button. Using the “UP” and ”DOWN” arrow buttons, select the "Start Percent" setting and hit "ENTER". Adjust the
setting and press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous Start Percent" setting is found in the "Nitrous Quick Setup" dialog box under the "Nitrous Graph" Tab.
Click the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown in the different
settings below. Press the "APPLY" button to confirm the changes.

Final Percent
This setting determines the Nitrous Final percentage. The Final Percent can be less than or greater than the Start
Percent setting. If the Start percent is greater than the Final percent the ramp will progress backwards.
The Valid Range is 0% to 100% in 1% increments.
Access from the Controller:
From the Main screen, select the stage by pressing the “N2O-1” button or the "N2O-2" button. Press the “DOWN”
arrow button repeatedly until the "Nitrous Quick Setup" menu selection is highlighted and then press the “ENTER”
button. Using the “UP” and ”DOWN” arrow buttons, select the "Final Percent" setting and hit "ENTER". Adjust the
setting and press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.
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Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous Final Percent" setting is found in the "Nitrous Quick Setup" dialog box under the "Nitrous Graph" Tab.
Click the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown in the different
settings below. Press the "APPLY" button to confirm the changes.

Build Time
This setting determines the time it takes for the Nitrous to ramp from the Start Percent to the Final Percent
settings. A Short build time will make the Nitrous Power Ramp more aggressive and a longer Build Time will make
it less aggressive.
The Valid Range is .200 to 9.900 seconds in .100 second increments.
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1” button or the "N2O-2" button. Press the
“DOWN” arrow button to highlight the "Nitrous Quick Setup" menu selection and then press the “ENTER” button.
Use the “UP” and ”DOWN” arrow buttons to select the "Build Time" setting and press the “ENTER” button. Using
the “LEFT” and ”RIGHT” arrow buttons to adjust the setting. Press the “SAVE” button to accept the new setting or
press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous Build TIme" setting is found in the "Nitrous Quick Setup" dialog box under the "Nitrous Graph" Tab. Click
the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown in the different
settings below. Press the "APPLY" button to confirm the changes.

Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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See Appendix B: Nitrous & Fuel Operation for more information.

6.3

Nitrous Graph Setup
Nitrous Setup
The Nitrous Percentage can be adjusted for each Pulse during the Progressive Ramp. This is done using a 2-D
Graph Editor. Please see basic editing Instructions below. The Fuel Percentage/Ramp can be adjusted
independently of the Nitrous (see Fuel Graph Setup).
Access from the Controller:
From the Main screen, select the stage by pressing either the “N2O-1” button or the "N2O-2 button. Press the
“DOWN” arrow button repeatedly until the "Nitrous Graph Setup" menu selection is highlighted and then press the
“ENTER” button. Use the “LEFT” and “RIGHT” arrow buttons to move through the Nitrous Progressive Ramp. To
Edit and/or change the Nitrous Progressive Ramp, move the cursor to the position to Edit and press the “EDIT”
button. The editing cursor will appear at the position selected. Using the “UP” and “DOWN” arrow buttons adjust
the new percentage setting. Press the “ENTER” button to accept the new setting. Use the “LEFT” and “RIGHT”
arrow buttons to move to the next set point. Each cursor position represents One pulse of the Nitrous Solenoid.
Press the “EDIT” button and adjust the Nitrous Percentage as outlined above. Press “ENTER” to accept the new
setting.
NOTE—When the two set points are more than one pulse apart the Progressive Ramp will be automatically filled
in between the set points.

Press the “MENU” button to Exit and/or Save the new setting(s). From the Menu select Exit and press “ENTER”.
You will then be prompted to Save the new settings or Exit without saving. After the Nitrous data is saved you will
be prompted to copy the Nitrous setup to the Fuel setup.
NOTE—There are several selections available when you press the “MENU” button. Please see below for an
explanation of each.
Edit:
Clear Edit Points:
View Old Data:
Restore Old Data:
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This selection exits the graph editor.
This selection will clear any edit points that are set in the Graph Screen. This does NOT
change any percentage setting, only the cursor is removed.
This selection will display the Progressive Ramp that is stored in memory.
This selection will restore the Progressive Ramp settings if any editing has been done
and NOT saved.

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

Zoom In:
Zoom Out:

This selection will zoom the X-Axis in.
This selection will zoom the X-Axis out.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
Nitrous Graph is displayed under the "Nitrous Graph" Tab. To move a single point, click on it and drag with mouse
up or down. You can use the "UP" and "Down" arrow keys to move the data point as well. By pressing CTRL +
UP/DOWN keys, you can move the data point in fine precision. To set an Edit point, double click on a data point.
An "X" will appear to mark the Edit point. When you select another point with a single click all points between the
Edit point and the Highlight point will auto fill as you drag the point. The SHIFT+LEFT/RIGHT keys move the
Highlight between data points. Use the scroll wheel and the right button on the mouse to zoom in or out. Single
click off from a data point and drag the mouse to move around a zoomed in window. Hit "ESC" to deselect the
edit point. You can also single click directly on highlighted Edit point to cancel. Click CTRL-Z to undo.

Right-clicking on the graph will display a menu from which the graph can be manipulated as well, as shown below.

IMPORTANT—When Saving a new Nitrous setup, the software will compare the Nitrous percentage settings to
the current Fuel percentage settings. If the Fuel percentage for a given pulse is less than the Nitrous percentage
minus the Fuel Trim percentage (See Setup Menu), then the Fuel percentage will automatically be adjusted to
Nitrous percentage minus the Fuel Trim percentage. If the Fuel Trim percentage is 0, this will result in the Fuel
percentage being greater than or equal to the Nitrous percentage. To allow full control of the Fuel percentage
Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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versus Nitrous percentage set the Fuel Trim Option to 100%. Do this with caution as a lean condition can and will
result if improper settings are entered!

See Appendix B: Nitrous & Fuel Operation for more information.

6.4

Fuel Graph Setup
Fuel Setup
The Fuel Percentage can be adjusted for each Pulse during the Progressive Ramp. This is done using a 2-D
Graph Editor. Please see Basic Editing Instructions below. The Fuel Percentage/Ramp can be adjusted
independently of the Nitrous (see Nitrous Graph Setup).
Access from the Controller:
From the Main screen, select the stage by pressing either the “N2O-1” button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the Fuel Graph Setup menu selection is highlighted and then press the
“ENTER” button. Use the “LEFT” and “RIGHT” arrow buttons to move through the Fuel Progressive Ramp. To Edit
and/or change the Fuel Progressive Ramp move the cursor to the position to Edit and press the “EDIT” button. The
editing cursor will appear at the position selected. Using the “UP” and “DOWN” arrow buttons adjust the new
percentage setting. The Fuel Percentage can NOT be set less than Nitrous Percentage - Fuel Trim (See
IMPORTANT note below) unless the fuel trim option is changed from the default value of 0%. Press the “ENTER”
button to accept the new setting. Use the “LEFT” and “RIGHT” arrow buttons to move to the next set point. Each
cursor position represents One pulse of the Fuel Solenoid. Press the “EDIT” button and adjust the Fuel
Percentage as outlined above. Press “ENTER” to accept the new setting.
NOTE—When the two set points are more than one pulse apart the Progressive Ramp will be automatically filled
in between the set points.

Press the “MENU” button to Exit and/or Save the new setting(s). From the Menu select Exit and press “ENTER”.
You will then be prompted to Save the new settings or Exit without saving.
NOTE—There are several selections available when you press the “MENU” button. Please see below for an
explanation of each.
Exit:
Clear Edit Points:
View Old Data:
Restore Old Data:
View Nitrous Data:
Copy Nitrous Data:
Zoom In:
Zoom Out:
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This selection exits the Graph Editor.
This selection will clear any Edit Points that are set in the Graph Screen. This
does NOT change any Percentage setting, only the Cursor is removed.
This selection will display the Progressive Ramp that is stored in memory.
This selection will restore the Progressive Ramp settings if any Editing has been
done and NOT Saved.
This selection will display the current Nitrous setup on the screen.
This selection will copy the current Nitrous setup to the Fuel setup.
This selection will Zoom the X-Axis in.
This selection will Zoom the X-Axis out.
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Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
Fuel Graph is displayed under the "Fuel Graph" Tab. To move a single point, click on it and drag with mouse up or
down. You can use the "UP" and "Down" arrow keys to move the data point as well. By pressing CTRL + UP/
DOWN keys, you can move the data point in fine precision. To set an Edit point, double click on a data point. An
"X" will appear to mark the Edit point. When you select another point with a single click all points between the
Edit point and the Highlight point will auto fill as you drag the point. The SHIFT+LEFT/RIGHT keys move the
Highlight between data points. Use the scroll wheel and the right button on the mouse to zoom in or out. Single
click off from a data point and drag the mouse to move around a zoomed in window. Hit "ESC" to deselect the
edit point. You can also single click directly on highlighted Edit point to cancel. Click CTRL-Z to undo. Rightclicking on the graph will display a menu from which the graph can be manipulated as well, as shown below the
graph.

Right-clicking on the graph will display a menu from which the graph can be manipulated as well, as shown below.

IMPORTANT—When Saving a new Fuel setup, the software will compare the Nitrous Percentage settings to the
current Fuel Percentage settings. If the Fuel Percentage for a given pulse is less than the Nitrous Percentage
minus the Fuel Trim percentage (See Setup Menu) the Fuel Percentage will automatically be adjusted to Nitrous
Percentage Fuel Trim. To allow full control of the Fuel Percentage versus Nitrous Percentage set the Fuel Trim
Option to 100%. Do this with caution as a Lean condition can and will result if improper settings are entered!

Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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See Appendix B: Nitrous & Fuel Operation for more information.

6.5

Nitrous Minimum RPM / Nitrous On RPM
This setting controls the minimum RPM level that the nitrous can be active (the nitrous-enabling RPM).
The valid range is 1,000 to 15,000 RPM in 100 RPM increments.
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1" button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Nitrous Min RPM" setting is highlighted and then press the “ENTER”
button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the
new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous On RPM" setting is found in the "Nitrous Control RPM" dialog box under the "Options" Tab. Click the
"UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.

6.6

Nitrous Maximum RPM / Nitrous Off RPM
This setting controls the maximum RPM level that the nitrous is active. Use this setting to disable the nitrous
when on the rev limiter.
The valid range is 2,000 to 16,000 RPM in 100 RPM increments.
Access from the Controller:
From the Main screen, select the stage by pressing either the “N2O-1” button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Nitrous Max RPM" setting is highlighted and then press the “ENTER”
button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the
new setting or press the “ESC” button to exit with no change.
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Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous Off RPM" setting is found in the "Nitrous Control RPM" dialog box under the "Options" Tab. Click the
"UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.

6.7

RPM Hysteresis Value / Hysteresis Percentage
This setting allows the user to specify the hysteresis percentage for the maximum and minimum (ON/OFF) RPM
nitrous settings. For the minimum (ON) RPM setting, this is the percentage below the set RPM point that will
disable nitrous. For the maximum (OFF) RPM setting, this is the percentage below the set RPM point that reenables the nitrous.
Refer to Appendix D: Glossary of Terms for an explanation of how a hysteresis works.
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O_1” button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "RPM Hysteresis %" setting is highlighted and then press the “ENTER”
button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the
new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Hysteresis %" setting is found in the "Nitrous Control RPM" dialog box under the "Options" Tab. Click the "UP"
and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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See Appendix B: Nitrous & Fuel Operation for more information.

6.8

Fuel Advance
This setting allows the fuel to start before the nitrous, therefore confirming that no nitrous flows without fuel
present. With the fuel operating at a lower pressure, this allows the proper amount of fuel to be delivered before
nitrous can flow. Some systems may not need any advance, while others may need more fuel advance than
others.
Valid Range is 0.000 to 0.250 seconds.
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1" button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Fuel Advance" menu selection is highlighted and then press the
“ENTER” button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to
accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Fuel Advance" setting is found in the "Fuel Advance Time" dialog box under the "Options" Tab. Click the "UP"
and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.

6.9

Nitrous Gear Position
This option allows the nitrous to be initiated by gear position. Example-if the nitrous shift count is set to 3rd gear
the nitrous would not start until the system is armed and the vehicle has reached 3rd gear. The Nitrous delay timer
will not start until the vehicle is in the selected gear position.
The valid range is integer numbers from 1 to 6.
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Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O_1” button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Nitrous Gear Pos" setting is highlighted and then press the “ENTER”
button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the
new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Gear Position" setting is found in the "Nitrous Start Gear Position" dialog box under the "Options" Tab. Click the
"UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.

6.10

Pulse Frequency
This setting determines the number of times per second that the solenoids pulse. A lower setting generally will
provide a more linear power delivery, as well as allow for lower starting percentages to be used. A higher pulse
frequency results in more solenoid pulses per second, which is displayed in the graph setup of the Nitrous Control
Center software by more data points. The correct setup will be different depending on the type of solenoids and
bottle pressure used. Testing is the only way to determine the best frequency for each application. This setting
applies to the respective nitrous and fuel solenoids of for each stage.
NOTE—When changing the pulse frequency the current Nitrous Setup will be time altered. Be sure to
check the Nitrous and Fuel Settings after a Frequency change!
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1" button or the "N2O-2" button. Press the
“DOWN” arrow button to highlight the Pulse Frequency menu selection and then press the “ENTER” button. Using
the “UP” and ”DOWN” buttons selected the desired Pulse Frequency setting. Press “ENTER” to select the new
setting or press “BACK” to exit with no change.

Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Pulse Frequency" setting is found in the "Stage Solenoid Pulse Freuency" dialog box under the "Options" Tab.
Click on one of the settings in the scroll-down menu to select the desired pulse frequency setting.

See Appendix B: Nitrous & Fuel Operation for more information.

6.11

Resume Start Percentage
This setting determines the percent at which the Nitrous resumes if the user has to lift the throttle after the nitrous
system is active. This setting is only valid if the Hold And Wait option is ON. This setting is used with the Resume
Percent Per Pulse setting to build a Resume Ramp. If the Resume Start Percent is greater than the current
Nitrous percent, the Resume Ramp is ignored.
Valid Range is 10% to 100% in 1% increments. A setting of 100% disables this feature (no ramp / instant ON).
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1" button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Resume Start Percent" menu selection is highlighted and then press
the “ENTER” button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to
accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Nitrous Resume %" setting is found in the "Nitrous Resume Ramp" dialog box under the "Options" Tab. Click
the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.

81

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

6.12

Resume Percent Per Pulse
This setting determines the rate at which the Nitrous Resumes if the user lifts the throttle during Arming. This
setting is used with the Resume Start Percent to build a Resume Ramp. This allows the user to adjust how quick
the Nitrous comes back on if one of the activation criteria is removed, causing the system to deactivate.
Valid Range is 10% to 50% in 1% increments.
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1" button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Resume % Per Pulse" menu selection is highlighted and then press
the “ENTER” button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to
accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Resume % Per Pulse" setting is found in the "Nitrous Resume Ramp" dialog box under the "Options" Tab. Click
the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.

6.13

Resume Fuel Percentage
This setting determines the percent at which the fuel resumes if the user has to lift off of the throttle once the
system is active. This setting is only valid if the Hold And Wait option is ON. This setting is used with the Resume
Percent Per Pulse setting to build a Resume Ramp. If the Resume Fuel Percent is greater than the current Fuel
percent, the Resume Ramp is ignored.
Valid Range is 10% to 100% in 1% increments. A setting of 100% disables this feature (no ramp).
Access from the Controller:
From the Main screen, select the stage by pressing either the "N2O-1" button or the "N2O-2" button. Press the
“DOWN” arrow button repeatedly until the "Resume Fuel %" menu selection is highlighted and then press the
“ENTER” button. Using the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to
accept the new setting or press the “ESC” button to exit with no change.

Nitrous Menus: Nitrous1 (N2O-1) and Nitrous2 (N2O-2)
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Access from the Computer Program:
From the Status screen, select the stage by pressing either the "Nitrous1" button or the "Nitrous2" button. The
"Resume % Per Pulse" setting is found in the "Nitrous Resume Ramp" dialog box under the "Options" Tab. Click
the "UP" and "DOWN" arrow buttons or type in any numeric value in the valid ranges shown above.

See Appendix B: Nitrous & Fuel Operation for more information.
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Setup Menu

Part

VII

7

Setup Menu
The following sub-sections detail the various features and settings located in the Setup Menu on the controller,
which can be accessed by pressing the far right navigation button on the NCC-001 controller. Some of these
options include using various sensors, vehicle RPM, or vehicle speed to control the arming of the system. Other
options in the Setup Menu, such as the Analog Output feature, allow the NCC-001 to control other devices.

7.1

Erase Data Log
This setting allows the user to manually erase the last data log from the NCC-001.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press "ENTER" to select the "Erase Data Log" menu selection.
Press the “YES” or “NO” button to change the current selection. If the “NO” button is pressed, the data log will not
be erased.

Access from the Computer Program:
From the Status screen, click on the Eraser Icon in the toolbar. Click "YES" to erase the data log from the
controller or "NO" to abort the operation.
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7.2

Analog Out Menu
The Analog Out voltage function of the NCC-001 can be used for NCC-001 related data to a data acquisition
system or to an ECM for external fuel or spark control, as well as to link to other devices, such as the LPE LNC2000 Launch Controller (LPE PN:L460145297) to create a progessive timing retard effect. Currently, the analog
output voltage signal can be user-defined versus time or proportional to the Nitrous1 graph, Nitrous2 graph, or a
combination of both nitrous graphs.

Setup Menu
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7.2.1

Graph Type
This setting allows for the Analog Out voltage to emulate the output of other components. Below are the available
settings and their respective descriptions.
Graph-Table Style
Nitrous1 Proportional
Nitrous2 Proportional
Nitrous 1 + 2 Proportional

The Analog Out
The Analog Out
The Analog Out
The Analog Out

signal
signal
signal
signal

will
will
will
will

follow the Analog Out Graph
follow the Stage 1 Nitrous Graph
follow the Stage 2 Nitrous Graph
follow a combination of both Nitrous Stage Graphs

Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the "Analog
Out Menu" is highlighted and then press the “ENTER” button two (2) times. Use the “UP” and ”DOWN” arrow
buttons to adjust the setting. Press the “ENTER” button to accept the new setting or press the “BACK” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "Analog Out" button. The "Output Control Style" setting is found in the
"Analog Out Style" dialog box. Click on one of the settings in the scroll-down menu to select the desired pulses
per degree setting.

7.2.2

Analog Out Graph Setup
The Analog Out Voltage can be adjusted for each Pulse during the Progressive Ramp. This is done using a 2-D
Graph Editor. Please see Basic Editing Instructions below. The Analog Out voltage can be used for Data
Recording or as an analog Input to a Electronic Fuel Injection controller. When used with some aftermarket EFI
systems, the analog output of the NCC-001 can be used to richen the fuel mixture and/or modify the ignition
timing.
The valid range for this output is 0.0 to 5.0 volts.
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Access from the Controller:
From the Main screen press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the "Analog
Out Menu" selection is highlighted and then press the “ENTER” button. Press the "DOWN" button until the
"Analog Out Graph Setup" is highlighted and then press the "ENTER" button. Use the “LEFT” and “RIGHT” arrow
buttons to move through the Analog Out settings. To Edit and/or change the Analog Out settings move the cursor
to the position to Edit and press the “EDIT” button. The editing cursor will appear at the position selected. Using
the “UP” and “DOWN” arrow buttons adjust the new setting. Press the “ENTER” button to accept the new setting.
Use the “LEFT” and “RIGHT” arrow buttons to move to the next set point. Each cursor position represents One
pulse of the Nitrous/Fuel Solenoid. Press the “EDIT” button and adjust the Analog Out voltage as outlined above.
Press “ENTER” to accept the new setting.
NOTE—When the two set points are more than one pulse apart the Analog Out voltage will be automatically
filled in between the set points.

There are several selections available when you press the “MENU” button. Below is the list of available options
along with their respective functions.
Exit:
Clear Data Points:
View Old Data:
Restore Old Data:
Zoom In:
Zoom Out:

This selection exits the Graph Editor
This selection will clear any edit points that are set in the Graph Screen. This does
NOT change any Percentage setting (only the cursor is removed).
This selection will display the Progressive Ramp that is stored in memory.
This selection will restore the Progressive Ramp settings if any editing has been done,
but not saved.
This selection will zoom the X-axis in.
This selection will zoom the X-axis out.

Press the “MENU” button to Exit and/or Save the new setting(s). From the Menu select Exit and press
“ENTER”. You will then be prompted to Save the new settings or Exit without saving.

Access from the Computer Program:
From the Status screen, click on the "Analog Out" button. To move a single point, click on it and drag with
mouse up or down. You can use the "UP" and "Down" arrow keys to move the data point as well. By pressing
CTRL + UP/DOWN keys, you can move the data point in fine precision. To set an Edit point, double click on a
data point. An "X" will appear to mark the Edit point. When you select another point with a single click all points
between the Edit point and the Highlight point will auto fill as you drag the point. The SHIFT+LEFT/RIGHT keys
move the Highlight between data points. Use the scroll wheel and the right button on the mouse to zoom in or
out. Single click off from a data point and drag the mouse to move around a zoomed in window. Hit "ESC" or
double click off from data point to cancel selected edit point. You can also single click directly on highlighted Edit
Setup Menu
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point to cancel. Click CTRL-Z to undo.

Right-clicking on the graph will display a menu from which the graph can be manipulated as well, as shown below.

See Appendix B: Nitrous & Fuel Operation for more information.

7.3

Timer Setup Menu
The Timer Out is a +12 volt output that can be controlled by the NCC-001 based on time or engine RPM.
The following options are available in the "TIMER SETUP" menu. If the Timer Output Option is set to a time based
output, the "Timer Delay" and "Timer Duration" settings will appear in the "Timer Output Menu", as shown below.
If the Timer Output Option is set to an RPM controlled window switch output, the "Timer On RPM", "Timer Off
RPM", and "RPM Hysteresis%" settings will appear in the "Timer Output Menu".
Access from the Controller:
From the Main screen, press the "Setup" button. Scroll down until until you find the "Timer Setup Menu"
button and press the "ENTER" button.
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Access from the Computer Program:
From the Status screen, press the "Timer" button.

Timer Output Option
The Timer Out function can function in either a timed output mode or as an RPM controlled window switch output.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” until the "Timer Output" menu selection is
highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Time-Based" option and
press ether the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no change will
be made.

Access from the Computer Program:
From the Status screen, press the "Timer" button. The "Time based" option is found in the "Timer Output Control
Method" dialog box under the "Options" Tab. Click "Time Based" to enable the timer-controlled output or "RPM
Based" to enable the RPM-controlled output.

Setup Menu
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Timer Hold
This setting determines if the +12V Timer Output remains On when the Arming signal is removed and the Hold &
Wait option is also on.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” until the Timer Hold menu selection is
highlighted and then press the “ENTER” button. Press the “YES” or “NO” button to change the current selection. If
the “NO” button is pressed no change will be made.
NOTE—When asked to make a selection from a “Message Box” the default selection will be chosen after 20
seconds.

Access from the Computer Program:
From the Status screen, press the "Timer" button. The "Time Hold" option is found in the "Timer Output Hold"
dialog box under the "Options" Tab. Click "ON" to enable the Timer Hold feature or "OFF" to disable the Timer
Hold feature.

Timer Delay
This setting controls the amount of Delay before the +12V Timer Output turns on after the nitrous system is
activated.
If a setting of 0.000 is entered the Timer Output will turn ON with the First Pulse of the Nitrous Solenoid. This
output can NOT be disabled and the user must remove any wires connected to the Output terminal to disable any
device connected.
The valid range is 0.000 to 9.990 in .01 second increments.
Access from the Controller:
From the Main screen press the “SETUP” button and then press the “ENTER” button. Press the "DOWN" button
continuously until the "Timer Setup Menu" is selected, then press "ENTER". Press the "DOWN" button
continuously until the "Timer Delay" setting is highlighted, then press "ENTER". Using the “LEFT” and ”RIGHT”
arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.
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Access from the Computer Program:
From the Status screen, press the "Timer" button. The "Timer Delay" option is found in the "Time Based Setup"
dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric value in
the valid ranges shown above.

Timer Duration
This setting controls the amount of time the Timer Out remains "ON" after the delay has expired. A setting of 0
will disable this option and the output will remain "ON" while the system is activated.
The valid range is 0.000-9.990 in .01 second increments.
Access from the Controller:
From the Main screen press the “SETUP” button and then press the “ENTER” button. Press the "DOWN" button
continuously until the "Timer Setup Menu" is selected, then press "ENTER". Press the "DOWN" button
continuously until the "Timer Duration" setting is highlighted, then press "ENTER". Using the “LEFT” and ”RIGHT”
arrow buttons, adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "Timer" button. The "Timer Duration" option is found in the "Time Based
Setup" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Setup Menu
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Timer RPM Output On
This setting controls the RPM at which the timer is activated if the timer is setup as a RPM window switch
controlled output. The RPM On setting must be at least 500 RPM's lower than the RPM Off setting.
The valid range is 1000-15500 in 100 RPM increments.
Access from the Controller:
From the Main screen press the “SETUP” button and then press the “ENTER” button. Press the "DOWN" button
continuously until the "Timer Setup Menu" is selected, then press "ENTER". Press the "DOWN" button
continuously until the "Timer On RPM" setting is highlighted, then press "ENTER". Using the “LEFT” and ”RIGHT”
arrow buttons, adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "Timer" button. The "Output RPM On" option is found in the "RPM Based
Setup" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Timer RPM Output Off
This setting controls the RPM at which the timer is deactivated if the timer is setup as a RPM window switch
controlled output. The RPM Off setting must be at least 500 RPM's higher than the RPM On setting.
The valid range is 2000-16000 in 100 RPM increments.
Access from the Controller:
From the Main screen press the “SETUP” button and then press the “ENTER” button. Press the "DOWN" button
continuously until the "Timer Setup Menu" is selected, then press "ENTER". Press the "DOWN" button
continuously until the "Timer Off RPM" setting is highlighted, then press "ENTER". Using the “LEFT” and ”RIGHT”
arrow buttons, adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.

93

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

Access from the Computer Program:
From the Status screen, press the "Timer" button. The "Output RPM Off" option is found in the "RPM Based
Setup" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

RPM Hysteresis Percentage
This setting controls the percentage of hysteresis for the engine RPM if the timer is setup as a RPM window
switch controlled output. The hysteresis percentage is based off of the full scale range (16000 RPM). For
example, you set the RPM On to 4000 and the RPM Off to 8000. The following chart shows the effect of a 1%
hysteresis on those values (1% of 16000 = 160 RPM):
Hysteresis
0%
1%

RPM On Setting = 4000
ON at 4000 RPM
OFF at 4000 RPM
ON at 4000 RPM
OFF at 3840 RPM

RPM Off setting = 8000
OFF at 8000 RPM
ON at 8000 RPM
OFF at 8000 RPM
ON at 7840 RPM

In the above example with a 0% hysteresis, as the engine RPM rises above 4000 RPM, the Timer Output is turned
on. Then, when engine speed exceeds 8000 RPM, the Timer Output is turned off. As the engine RPM drops, the
Timer Output is turned on when the engine speed drops below 8000 RPM and is then turned off when the engine
speed drops below 4000 RPM. With a 1% hysteresis, the values would be the same when the engine speed is
increasing, but as the engine RPM drops, the Timer Output is turned on when the engine speed drops below 7840
RPM and is turned off when the engine speed drops below 3840 RPM.
For more information on hysteresis values, refer to Appendix D: Glossary of Terms.
The valid range is 0.0-5.0 in 0.1% increments.
Access from the Controller:
From the Main screen press the “SETUP” button and then press the “ENTER” button. Press the "DOWN" button
continuously until the "Timer Setup Menu" is selected, then press "ENTER". Press the "DOWN" button
continuously until the "RPM Hysteresis%" setting is highlighted, then press "ENTER". Using the “LEFT” and
”RIGHT” arrow buttons, adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC”
button to exit with no change.

Access from the Computer Program:
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From the Status screen, press the "Timer" button. The "Hysteresis%" option is found in the "RPM Based Setup"
dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric value in
the valid ranges shown above.

7.4

Shift Setup Menu
The following options and settings can be found in the Shift Setup Menu.

Shift RPM
This setting controls the RPM to activate the +12 volt Shift Light output on the NCC-001.
The Valid Range is 1000 to 16000 RPM in 100 RPM increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Shift Setup
menu selection is highlighted and then press the “ENTER” button twice. Using the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Shift RPM" button. The "Shift RPM Default" option is found in the "Shift RPM
(s)" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric value
in the valid ranges shown above.

7.5

Throttle Position Sensor (TPS) Setup Menu
The following options are found in the TPS setup menu, which can be accessed by the "SETUP" button on the
main screen of the controller or the TPS Input tab on the Setup screen of the computer software. The TPS
accepts rising or falling voltage signals. Note that the Throttle Position Sensor (TPS) and the Accelerator Pedal
Position sensor (APP) are NOT the same. While both the TPS and APP sensors function by relaying a voltage to
the ECM that translates into the degree of engagement, the measurements and their consequential voltages are
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not the same. While the NCC-001 can accept either signal, LPE recommends that the NCC-001 be connected to
the TPS in most cases.
See Appendix D: Glossary of Terms for more information on the Throttle Position Sensor.

TPS Activation Option
The TPS Activation Option allows the throttle position sensor input to control system activation. The Arming Input
must be used even if this option is selected.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the TPS Setup
Menu selection is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the TPS
Arming Option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "TPS Activation Enable" option is found under the "TPS
Input" Tab. Click "ON" to enable the TPS Activation Enable feature or "OFF" to disable the feature.

Activation Percentage
The TPS Activation Percentage setting determines the TPS percent at which system activation will occur based
on TPS alone (other activating criteria must also be met).
The Valid Range is 10% to 100% in 0.1% increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the TPS
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the
"Activation%" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.
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Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Activation Percent" setting is found in the "TPS
Activation Percent" dialog box under the "TPS Input" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

Hysteresis Percentage
This setting determines the TPS Activation Hysteresis Percentage. Refer to Appendix D: Glossary of Terms for
an explanation of how a hysteresis works.
The Valid range is 0.1% to 5.0% in 0.1% increments (of full scale, 100%).
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the TPS
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the
"Hysteresis%" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Activation Hysteresis" setting is found in the "TPS
Activation Percent" dialog box under the "TPS Input" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.
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Set TPS Voltage
The TPS closed and wide open throttle input values can be set using live data from the TPS Input or these values
can be set manually. Due to the fact that the controller is reading live data from the vehicle, this method of
determining the TPS voltage settings is not available in the Nitrous Control Center computer software interface. It
is important to note that the butterfly valve on most electronic throttle body vehicles is not fully closed when the
vehicle is idling. For this reason, the vehicle should not be running when setting the TPS voltage using this
method.
NOTE: If you choose to use this method to set your minimum and maximum TPS voltages on a vehicle equipped
with an electronic throttle body, it will require the use of an assistant to hold the throttle completely open or closed
while setting the voltages on the controller.
Access from the Controller:
From the Main screen, press the "SETUP" button. Press the "DOWN" button repeatedly until the TPS Setup
Menu selection is highlighted, and then press the "ENTER" button. Press the down arrow until the "Set TPS
Voltage" selection is highlighted and then press the "ENTER" button.
For a vehicle equipped with an electronic throttle body:
1. Remove the vehicle's air duct to expose the butterfly valve in the throttle body
2. With the key in the ignition, turn the key to the ON position, but DO NOT start the vehicle.
3. Have your assistant physically shut the butterfly valve in the throttle body.
4. With the gas pedal completely released, press the "SET MIN" button.
5. Next, have your assistant physically hold the throttle body butterfly valve completely open.
6. With the gas pedal completely depressed, press the "SET MAX" button.
For a vehicle equipped with a mechanical throttle body:
1. With the key in the ignition, turn the key to the ON position, but DO NOT start the vehicle.
2. With the gas pedal completely released, press the "SET MIN" button.
3. With the gas pedal completely depressed, press the "SET MAX" button.

Manually Set Closed Throttle TPS Voltage
This setting allows the user to manually select the voltage with the Throttle Position Sensor in the closed position.
The Valid Range is 0.00 to 5.00 volts in 0.01 volt increments.
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Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the TPS
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Manual
Set Min Volts" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Closed Throttle Voltage" setting is found in the "TPS
Input Setup" dialog box under the "TPS Input" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

Manually Set Maximum Wide Open Throttle TPS Voltage
This setting allows the user to manually select the voltage with the Throttle Position Sensor in the wide open
position.
The Valid Range is 0.00 to 5.00 volts in 0.01 volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button, press the “DOWN” arrow button repeatedly until the TPS Setup
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Manual Set
Max Volts" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "TPS WOT Voltage" setting is found in the "TPS Input
Setup" dialog box under the "TPS Input" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
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value in the valid ranges shown above.

7.6

Analog1 Setup Menu
The Analog Clutch Options and settings are available in the Analog1 Setup Menu. The current input options for
Analog1 are OFF or Clutch Position Sensor input.

Analog1 Clutch Option
The Analog Clutch Option allows the NCC-001 to read the clutch position sensor on vehicles with a 0-5 volt output
clutch position sensor. The clutch, therefore, becomes an activation enabler. Many newer vehicles use a clutch
sensor as opposed to the traditional clutch switch. This feature accepts rising or falling input types.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Analog1
Setup Menu selection is highlighted and then press the “ENTER” button. Once in the Analog1 Setup menu, press
the "ENTER" button to select the Analog Clutch option. Press the “YES” or “NO” button to change the current
selection. If the “NO” button is pressed no change will be made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Analog Clutch Input" option is found in the "Analog1
Config" dialog box under the "Analog1" Tab. Click "Analog Clutch Input" to enable the Analog Clutch Input feature
or "OFF" to disable the feature.

Analog1 Clutch Activation Percentage
This setting allows the user to define at what clutch percentage the clutch arming occurs.
Setup Menu
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The valid range is 10.0-100.0 percent in 0.1 percent increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Analog1
Setup Menu selection is highlighted, and then press the “ENTER” button twice. Press the down arrow until the
"Activation%" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Activation Percent" setting is found in the "Analog Clutch
Setup" dialog box under the "Analog1" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Analog1 Clutch Activation Hysteresis
This setting allows the user to set a hysteresis percentage for the clutch activation percentage. Refer to Appendix
D: Glossary of Terms for an explanation of how a hysteresis works.
The valid range is 0.0% to 5.0% in 0.1% increments (of full scale, 100%).
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Analog1
Setup Menu selection is highlighted, and then press the “ENTER” button twice. Press the down arrow until the
"Hysteresis%" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.
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Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Activation Hystersis" setting is found in the "Analog
Clutch Setup" dialog box under the "Analog1" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

Calibrate Clutch Pedal Position Sensor Signal
This option is only available on the controller and allows the user to set the released and depressed clutch
voltages using live data from the vehicle.
The valid range is 0.00-5.00 in 0.01 Volt increments.
Access from the Controller:
From the Main screen, press the "SETUP" button. Press the "DOWN" button repeatedly until the Analog1 Setup
Menu selection is highlighted, and then press the "ENTER" button twice. Press the down arrow until the "Set
Clutch Voltage" selection is highlighted and then press the "ENTER" button. With the vehicle powered up and the
clutch pedal released, press the "SET MIN" button. Next, fully depress the clutch pedal and press the "SET MAX"
button. The clutch voltages that were observed by the controller will be displayed and this should be used to verify
correct operation.

OR
Manually Set Clutch Pedal Released Voltage

Setup Menu

102

This setting allows the user to manually set the input voltage seen by the controller when the clutch pedal is
released.
The valid range is 0.00-5.00 in 0.01 volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Analog1
Setup Menu selection is highlighted, and then press the “ENTER” button twice. Press the down arrow until the
"Set Released Voltage" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT”
arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to
exit with no change.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Clutch Pedal Released Voltage" setting is found in the
"Analog Clutch Setup" dialog box under the "Analog1" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

Manually Set Clutch Pedal Depressed Voltage
This setting allows the user to manually set the input voltage seen by the controller when the clutch pedal is
depressed.
The valid range is 0.00-5.00 in 0.01 Volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Analog1
Setup Menu selection is highlighted, and then press the “ENTER” button twice. Press the down arrow until the
"Set Depressed Voltage" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and
”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC”
button to exit with no change.

103

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Clutch Pedal Depressed Voltage" setting is found in the
"Analog Clutch Setup" dialog box under the "Analog1" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

7.7

Analog2 Setup Menu
There is currently one setting, Data Log Erase Option, available in the Analog2 Setup Menu.
Activating the Data Log Erase Option allows the Data Log memory to be Erased/Activated by applying a +5V
to +12V signal to the Analog2 Input. This option allows you to put a user controlled switch in the vehicle to
manually erase the data log.

Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Analog2
Setup Menu selection is highlighted and then press the “ENTER” button. Once in the Analog2 Setup menu, press
the "ENTER" button to select the Erase option. Press the “YES” or “NO” button to change the current selection. If
the “NO” button is pressed no change will be made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Data Log Erase Enable" option is found in the "Analog2
Config" dialog box under the "Analog2" Tab. Check the box to enable the Data Log Erase Option or un-check the
box to disable the option.
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7.8

AFR Setup Menu
The following options are found in the AFR setup menu, which can be accessed by the "SETUP" button on the
main screen of the controller or through the Air-Fuel Ratio tab in the setup menu of the computer software. The
Air-Fuel Ratio can be read into the NCC-001 and logged. The AFR signal must be a 0-5 volt linear signal.
This feature can also be used as a safety feature to disable nitrous. By enabling the AFR option, the O2
wideband controller can be used to detect a lean condition. The controller can then disable the nitrous
accordingly.

AFR Option
By enabling the AFR option, the 0-5 volt output from an O2 wideband controller can be used to disable the nitrous
system if a lean cylinder condition is detected.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR
Setup Menu selection is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the
"AFR Option", then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "AFR Nitrous Disable" option is found under the "Air
Fuel Ratio" Tab. Click "ON" to disable the AFR Nitrous feature or "OFF" to Enable the feature.

AFR Nitrous Oxide Disable
This setting determines the Air Fuel Ratio at which the nitrous system is disabled due to a lean condition. A
setting of 0.0 will disable this feature. This setting is used along with the AFR Delay and AFR Disable Percent
settings.
The Valid Range is 0.0 to 20.0 in .1 increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR Setup
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Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR NOX
Disable" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Nitrous Disable" setting is found in the "AFR
Disable Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

AFR Nitrous Disable Delay
This setting controls the amount of time the Air Fuel Ratio must be above the AFR Disable setting before disabling
the nitrous system. This allows the system to filter out short Lean spikes.
The Valid Range is 0.000 to 1.000 Seconds in .01 second increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR
Disable Delay" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Disable Delay" setting is found in the "AFR Disable
Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.
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AFR Nitrous Disable Percentage
This setting determines at what Nitrous Percent (Duty Cycle) the Wideband Disable function is active. When the
progressive ramp first begins the system will not be at 100% nitrous. Use this setting to determine at what Nitrous
Percent the Wideband Nitrous Disable function becomes active.
Example - When the Nitrous is first armed the air-fuel is 12.8 to 1 and the Wideband Disable Voltage is set to turn
off the nitrous if the system is 12 to 1 or above. This setting would allow the Nitrous and fuel to begin flowing and
get to an air-fuel ratio that is below the disable setting.
The Valid Range is 10% to 100% in 1% increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR Setup
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR Disable
%" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons adjust
the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Disable Percent" setting is found in the "AFR
Disable Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

AFR Minimum Voltage
This setting should be set to the voltage that the Wideband controller outputs at the minimum/rich AFR range.
The Valid Range is 0.0 to 5.0 volts in .1 volt increments.
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Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR
Min Voltage" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Minimum Voltage" setting is found in the "AFR
Input Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

AFR Maximum Voltage
This setting should be set to the voltage that the Wideband controller outputs at the maximum/lean AFR range.
The Valid Range is 0.0 to 5.0 volts in .1 volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR
Max Voltage" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.
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Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Maximum Voltage" setting is found in the "AFR
Input Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

AFR Minimum Value
This setting should be the Air Fuel Ratio that corresponds to the AFR Minimum voltage.
The Valid Range is 0.0 to 24.0 in .1 increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR Setup
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR Min
Value" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Minimum Value" setting is found in the "AFR Input
Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

AFR Maximum Value
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This setting should be the Air Fuel Ratio that corresponds to the AFR Maximum voltage.
The Valid Range is 0.0 to 24.0 in .1 increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the AFR
Setup Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "AFR
Max Value" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow
buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit
with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "AFR Maximum Value" setting is found in the "AFR Input
Setup" dialog box under the "Air Fuel Ratio" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

7.9

Relay1 and Relay2 Setup Menus
The Relay1 output is a NCC-001 controlled ground output. The Relay2 output is a NCC-001 controlled +12 volt
output.
The following options are found in both the Relay1 and Relay2 setup menus, which can be accessed by the
"SETUP" button on the main screen or through the Relay1 and Relay2 buttons in the computer software. The
control options found in these menus are used to determine the parameters for enabling either Relay1 or Relay2.
Any combination of enabling control options can be used to enable Relay1 and Relay2.

Arming Input Control Option
If this option is enabled, the selected Relay output is controlled by the state of the Arming Input and any other
control options that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Act Input
Setup Menu
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Ctrl" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Arming Input Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the
Arming Input Control Option or un-check the box to disable the option.

Clutch Input Control Option
If this option is enabled, the selected Relay output is controlled by the state of the Clutch Input and any other
control options that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Clutch
Input Ctrl" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Clutch Input Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the
Clutch Input Control Option or un-check the box to disable the option.

Shift Input Control Option
If this option is enabled, the selected Relay output is controlled by the state of the Shift input and any other
control options that are enabled.
Access from the Controller:
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From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Shift
Input Ctrl" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The "Shift
Input Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the Shift Input
Control Option or un-check the box to disable the option.

Throttle Position Sensor (TPS) Percentage Control Option
If this option is enabled, the selected Relay output is controlled by TPS input and any other control options that
are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "TPS
Percent Ctrl" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed
no change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Throttle Input Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the
Throttle Input Percentage Control Option or un-check the box to disable the option.
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Air-Fuel Ratio (AFR) Control Option
If this option is enabled, the selected Relay output is controlled by AFR input and any other control options that
are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "AFR
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The "AFR
Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the AFR Control
Option or un-check the box to disable the option.

Nitrous1 Percentage Control Option
If this option is enabled, the selected Relay output is controlled by Nitrous1 duty cycle and any other control
options that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the
"Nitrous1% Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is
pressed no change will be made.

Access from the Computer Program:
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From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Nitrous1 Percent Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable
the Nitrous1 Percentage Control Option or un-check the box to disable the option.

Fuel1 Percentage Control Option
If this option is enabled, the selected Relay output is controlled by Fuel1 duty cycle and any other control options
that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Fuel1%
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Fuel1 Percent Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the
Fuel1 Percentage Control Option or un-check the box to disable the option.

Nitrous2 Percentage Control Option
If this option is enabled, the selected Relay output is controlled by Nitrous2 duty cycle and any other control
options that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the
"Nitrous2% Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is
pressed no change will be made.
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Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Nitrous2 Percent Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable
the Nitrous2 Percentage Control Option or un-check the box to disable the option.

Fuel2 Percentage Control Option
If this option is enabled, the selected Relay output is controlled by Fuel2 duty cycle and any other control options
that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Fuel2%
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Fuel2 Percent Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the
Fuel2 Percentage Control Option or un-check the box to disable the option.
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RPM Control Option
If this option is enabled, the selected Relay output is controlled by the engine RPM and any other control options
that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "RPM
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The "RPM
Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the RPM Control
Option or un-check the box to disable the option.

MPH Control Option
If this option is enabled, the selected Relay output is controlled by the vehicle MPH and any other control options
that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "MPH
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Setup Menu

116

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The "MPH
Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the MPH Control
Option or un-check the box to disable the option.

Fuel Pressure Control Option
If this option is enabled, the selected Relay output is controlled by the Fuel pressure and any other control options
that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Fuel PSI
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The "Fuel
PSI Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the Fuel
Pressure Control Option or un-check the box to disable the option.

Nitrous Pressure Control Option
If this option is enabled, the selected Relay output is controlled by the Nitrous pressure and any other control
options that are enabled.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the desired
Relay Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "N2O PSI
Control" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
117

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

change will be made.

Access from the Computer Program:
From the Status screen, select the relay by pressing either the "Relay1" button or the "Relay2" button. The
"Nitrous PSI Enable" option is located in the "Relay Control Options" dialog box. Check the box to enable the
Nitrous Pressure Control Option or un-check the box to disable the option.

7.10

PWM Out Menu
This menu is not currently functional, but will be used in future software builds.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the "PWM
Out Menu" selection is highlighted and then press the “ENTER” button. This menu is not currently functional, so
press "OK" to exit.

7.11

Hall Input Menu
The following options are found in the Hall Input Menu, which can be accessed by the "SETUP" button on the
main screen or by clicking Hall Input tab in the Setup menu of the computer software. Currently, this input can
only be used for vehicle speed signal input.

MPH Option
This option enables the input settings used to configure the Hall Input to monitor vehicle speed. The input signal
needs to be a square wave signal or connected to the output of an open drain hall effect sensor. The Pulse Per
Mile setting in the ECM must be configured properly for an accurate reading.
The Hall Input has a programmable Pull-Up resistor for use in applications that require a Pull-Up resistor, but do
not already have one in the circuit.
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Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Hall Input
Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "MPH" option,
then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no change will be
made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Mile Per Hour" option is found in the "Hall Input Config"
dialog box under the "Hall Input" tab. Click "Mile Per Hour" to enable the MPH option or "OFF" to disable the
option. If the Hall Input is turned "ON" in the computer software program, the user will also have the ability to
enable either stage of nitrous via the vehicle MPH. In order for the controller to accurately read the vehicle MPH,
the Pulse Per Mile setting must be calibrated correctly.

Nitrous1 and Nitrous2 MPH Activation Option
This option allows the user to enable or disable MPH activation control for the Nitrous1 and Nitrous2 Channels.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Hall Input
Menu is highlighted and then press the “ENTER” button twice. Press the "DOWN" arrow button until either the
Nitrous1 or Nitrous2 MPH Activation option is highlighted, then press "ENTER". Press the “YES” or “NO” button
to change the current selection. If the “NO” button is pressed no change will be made.
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Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Nitrous1 MPH Activation Enable" and "Nitrous2 MPH
Activation Enable" options are found in the "MPH Setup" dialog box under the "Hall Input" tab. Click "ON" to
enable the MPH option or "OFF" to disable the option.

Nitrous1 and Nitrous2 Minimum (ON) MPH Setting
This setting dictates the minimum MPH at which either Nitrous1 or Nitrous2 can still be active.
The valid range is 0-255 in 1 MPH increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Hall Input
Menu selection is highlighted, and then press the “ENTER” button twice. Press the "DOWN" arrow button until the
either the Nitrous1 or Nitrous2 minimum MPH selection is highlighted and then press the "ENTER" button. Use
the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or
press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press either the "Nitrous1" or "Nitrous2" buttons. The "Nitrous ON MPH" setting is found
in the "Nitrous Control MPH" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or
type in any numeric value in the valid ranges shown above.
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Nitrous1 and Nitrous2 Maximum (OFF) MPH Setting
This setting dictates the maximum MPH at which either Nitrous1 or Nitrous2 is activated.
The valid range is 0-255 in 1 MPH increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Hall Input
Menu selection is highlighted, and then press the “ENTER” button twice. Press the "DOWN" arrow button until the
either the Nitrous1 or Nitrous2 maximum MPH selection is highlighted and then press the "ENTER" button. Use
the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or
press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press either the "Nitrous1" or "Nitrous2" buttons. The "Nitrous OFF MPH" setting is
found in the "Nitrous Control MPH" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow
buttons or type in any numeric value in the valid ranges shown above.

Nitrous1 and Nitrous2 MPH Hysteresis Percentage Setting
This setting determines the hysteresis percentage for the activation of both nitrous stages at the minimum and
maximum MPH. Refer to Appendix D: Glossary of Terms for an explanation of how a hysteresis works.
The valid range is 0.0%-5.0% in 0.1% increments (percentage of full scale, 255 MPH). 1% is 2.55 MPH.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Hall Input
Menu selection is highlighted, and then press the “ENTER” button twice. Press the "DOWN" arrow button until the
either the MPH1 or MPH2 hysteresis percentage selection is highlighted and then press the "ENTER" button.
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Use the “LEFT” and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting
or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press either the "Nitrous1" or "Nitrous2" buttons. The "Hysteresis" setting is found in the
"Nitrous Control MPH" dialog box under the "Options" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

Pulse Per Mile Setting (Live Data)
This option is only available on the controller and allows the user to set the correct Pulse Per Mile setting for the
vehicle using live data from the vehicle.
The valid range is 1000-20000 in 1 Pulse Per Mile (PPM) increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Hall Input
Menu selection is highlighted, and then press the “ENTER” button twice. Press the "DOWN" arrow button until the
either the "Pulse Per Mile" selection is highlighted and then press the "ENTER" button. Once the vehicle is going
60 miles per hour, press the "SET" button to accept the new Pulse per mile calibration or press the "BACK"
button to exit with no change.

Manual Pulse Per Mile Setting
This setting allows the user to manually set the number of pulses per mile.
The valid range is 1000-20000 in 1 Pulse Per Mile (PPM) increments.
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Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Hall Input
Menu selection is highlighted, and then press the “ENTER” button twice. Press the "DOWN" arrow button until the
either the "Manual Pulse Per Mile" selection is highlighted and then press the "ENTER" button. Use the “LEFT”
and ”RIGHT” arrow buttons adjust the setting. Press the “SAVE” button to accept the new setting or press the
“ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Pulse Per Mile" setting is found in the "MPH Setup"
dialog box under the "Hall Input" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric value in
the valid ranges shown above.

Hall Pull-Up Option
This option enables or disables a 4.7k Ohm pull-up resistor to +12V on the Hall Input terminal. This option is
normally used when connecting to the vehicle speed signal output from an ECM that is not connected to any other
systems or modules in the vehicle. On vehicles that already have this signal connected, a Pull-Up resistor is
normally already in the circuit. You DO NOT want to have multiple Pull-Up resistors in the circuit.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Hall Input
Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Hall Pull-up"
option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no change will
be made.

123

Lingenfelter NCC-001 Nitrous Control Center Installation and Operating Instructions

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Hall Input Pull-Up Resistor Enable" option is found
under the "Hall Input" tab. Click "ON" to enable the Hall Pull-Up resistor feature or "OFF" to disable the feature.

7.12

Fuel PSI Menu
The following options are found in the Fuel PSI Menu, which can be accessed by the "SETUP" button on the main
screen or by clicking the Fuel Sensor tab in the Setup menu of the computer software. The fuel pressure menu
allows the user to data log the fuel pressure in order to disable nitrous when necessary based on the observed fuel
pressure. By having fuel pressure input into the NCC-001, you can also use the relay outputs to trigger an
auxiliary fuel pump based on the desired fuel pressure.

Default Sensor Setup Option
Use this to configure the controller to select the sensor calibration curve. There are two (2) standard sensors
available from LPE, both of which are pre-loaded into the NCC-001 firmware. If you don't plan to use one of the
LPE sensors, you can manually enter the calibration points. Whatever fuel pressure sensors are chosen for the
application, they MUST be 0-5 volt linear output sensors.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Default Sensor
Setup" option, then the “UP” or “DOWN” button to change the current selection. If the “BACK” button is pressed
no change will be made.
As shown in the screen shot below, the default fuel pressure sensors are:
L480250015: 0-15 PSI sensor
L480260150: 0-150 PSI sensor

Access from the Computer Program:
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From the Status screen, press the "SETUP" button. The "Default Fuel Sensor" setting is found under the "Fuel
Sensor" Tab. Click on one of the settings in the scroll-down menu and click "Accept" to select the default fuel
sensor setting.

Fuel Pressure Minimum Voltage
This setting should be set to the voltage the Fuel Sensor outputs at the minimum fuel pressure.
The Valid Range is 0.0 to 5.0 volts in .1 volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel PSI Min
Volt" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Min Voltage" option is found in the "Fuel Sensor
Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Fuel Pressure Maximum Voltage
This setting should be set to the voltage the Fuel Sensor outputs at the maximum fuel pressure.
The Valid Range is 0.0 to 5.0 volts in .1 volt increments.
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Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel PSI Max
Volt" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Max Voltage" option is found in the "Fuel Sensor
Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Fuel Pressure Minimum Value
This setting should be the fuel pressure that corresponds to the fuel sensor minimum voltage.
The Valid Range is 0 to 250 PSI in 1 PSI increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel PSI Min
Value" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
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From the Status screen, press the "Setup" button. The "Sensor Min PSI" option is found in the "Fuel Sensor
Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Fuel Pressure Maximum Value
This setting should be the fuel pressure that corresponds to the fuel sensor maximum voltage.
The Valid Range is 0 to 250 PSI in 1 PSI increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel PSI Max
Value" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Max PSI" option is found in the "Fuel Sensor
Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any numeric
value in the valid ranges shown above.

Fuel Pressure Option / Fuel PSI Nitrous Disable
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Enabling the Fuel Pressure Option will allow the flow of nitrous to be disabled based on a user defined fuel
pressure.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Fuel PSI"
option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no change will
be made.

Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Fuel Pressure Nitrous Disable" option is found in the
"Fuel PSI Nitrous Disable" dialog box under the "Fuel Sensor" tab. Click to "ON" button to enable the Fuel
Pressure Nitrous Disable option or "OFF" to disable the option. If the option is enabled, Click the "UP" and
"DOWN" arrow buttons or type in any numeric value to change the settings.

Fuel PSI Nitrous Oxide Disable
This setting determines the fuel pressure at which the nitrous system is disabled. A setting of 0.0 will disable this
feature. This setting is used along with the Fuel PSI Delay and Fuel PSI Disable Percent settings.
The Valid Range is 0.0 to 150.0 PSI in .1 PSI increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel PSI
Disable" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Fuel PSI Nitrous Disable" setting is found in the "Fuel
PSI Disable Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in
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any numeric value in the valid ranges shown above.

Fuel PSI Nitrous Disable Delay
This setting controls the amount of time the Fuel Pressure must be below the Fuel PSI disable setting before
disabling the nitrous system.
The Valid Range is 0.000 to 1.000 Seconds in .01 Second increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel Disable
Delay" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Fuel PSI Disable Delay" setting is found in the "Fuel PSI
Disable Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

Fuel PSI Nitrous Disable Percentage
This setting allows the user to tell the the controller to only disable the nitrous using the fuel pressure disable
option if the nitrous is ramped up above the set percentage.
For example- If the Fuel PSI disable percentage setting is set to 60%, the nitrous cannot be disabled by the Fuel
PSI option until the nitrous is ramped above 60%, even if the fuel pressure is below the Fuel PSI nitrous disable
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setting.
The Valid Range is 0% to 100% in 1% increments.
Access from the Controller:
From the Main screen, press the “SETUP” button. Press the “DOWN” arrow button repeatedly until the Fuel PSI
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "Fuel Disable
%" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons adjust
the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Fuel PSI Disable Percent" setting is found in the "Fuel
PSI Disable Setup" dialog box under the "Fuel Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

7.13

Nitrous PSI Menu
The following options are found in the Nitrous PSI Menu, which can be accessed by the "SETUP" button on the
main screen or by clicking the Nitrous Sensor tab in the Setup menu of the computer software. This menu allows
the user to data log the nitrous pressure. Having this sensor in the system allows you to perform closed loop
bottle heater control using one of the NCC-001 relay outputs.

Default Sensor Setup
Use this setting to configure the controller to use the default nitrous pressure sensor. If you are not using the
default LPE 0-2000 PSI nitrous pressure sensor (PN: 480272000), the chosen sensor for the application MUST be
a 0-5 volt linear output sensor.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Nitrous PSI
Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Default Sensor
Setup" option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no
change will be made.
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Access from the Computer Program:
From the Status screen, press the "SETUP" button. The "Default Nitrous Sensor" setting is found under the
"Nitrous Sensor" Tab. Click "Accept" to select the default fuel sensor setting.

Nitrous Pressure Minimum Voltage
This setting should be set to the voltage the Nitrous Sensor outputs at the minimum nitrous pressure.
The Valid Range is 0.0 to 5.0 volts in .1 volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Fuel Psi
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "N2O Psi Min
Volt" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Min Voltage" option is found in the "Nitrous
Sensor Setup" dialog box under the "Nitrous Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.
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Nitrous Pressure Maximum Voltage
This setting should be set to the voltage the Nitrous Sensor outputs at the maximum nitrous pressure.
The Valid Range is 0.0 to 5.0 volts in .1 volt increments.
Access from the Controller:
From the Main screen, press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Fuel Psi
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "N2O Psi Max
Volt" selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons
adjust the setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no
change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Max Voltage" option is found in the "Nitrous
Sensor Setup" dialog box under the "Nitrous Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in
any numeric value in the valid ranges shown above.

Nitrous Pressure Minimum Value
This setting should be the nitrous pressure that corresponds to the Nitrous sensor minimum voltage.
The Valid Range is 0 to 2000 psi in 1 psi increments.
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Access from the Controller:
From the Main screen, press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Fuel Psi
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "N2O Psi Min"
selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons adjust the
setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Min PSI" option is found in the "Nitrous Sensor
Setup" dialog box under the "Nitrous Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
numeric value in the valid ranges shown above.

Nitrous Pressure Maximum Value
This setting should be the nitrous pressure that corresponds to the Nitrous sensor maximum voltage.
The Valid Range is 0 to 2000 psi in 1 psi increments.
Access from the Controller:
From the Main screen, press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Fuel Psi
Menu selection is highlighted, and then press the “ENTER” button. Press the down arrow until the "N2O Psi Max"
selection is highlighted and then press the "ENTER" button. Use the “LEFT” and ”RIGHT” arrow buttons adjust the
setting. Press the “SAVE” button to accept the new setting or press the “ESC” button to exit with no change.

Access from the Computer Program:
From the Status screen, press the "Setup" button. The "Sensor Max PSI" option is found in the "Nitrous Sensor
Setup" dialog box under the "Nitrous Sensor" Tab. Click the "UP" and "DOWN" arrow buttons or type in any
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numeric value in the valid ranges shown above.

7.14

Data Log Menu
The following options are found in the Data Log Menu, which can be accessed by the "SETUP" button on the main
screen or by clicking the Options tab in the Data menu of the computer software. The settings in this menu allow
the controller to log data only after the criteria in the following sub-sections are satisfied. The data log enable
parameters are any parameters that, along with the arming input, allow the controller to log data. If no data log
enable parameters are selected, the controller will start the data log when the arming switch is activated. Once the
data log is activated, the logging of data will continue even if the data log enable parameters fall below their
present settings.

Clutch Enable Option
Enabling the Clutch Enable Option allows the NCC-001 to log data when the clutch is released after the arming
switch and clutch pedal are engaged. In other words, data logging is disabled while the clutch pedal is depressed.
When the clutch pedal is released, the data logging feature is enabled. In order to prevent the data log from
beginning prematurely, the arming switch should be enabled after the clutch is engaged. Note: This option applies
to the Clutch Input signal and not the CPP Sensor on Analog1.
Example - You have already staged and are at the starting line ready to launch. Depress the clutch, engage the
arming switch, and the data log feature will engage when the clutch is released.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Data Log
Menu is highlighted and then press the “ENTER” button. Press the "ENTER" button to select the "Clutch Enable"
option, then the “YES” or “NO” button to change the current selection. If the “NO” button is pressed no change will
be made.

Access from the Computer Program:
From the Status screen, press the "Data" button. The "Clutch Input" option is found in the "Data Log Enable
Parameters" dialog box under the "Options" Tab.
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TPS Enable Option
Enabling the TPS Enable Option disables the data log feature of the NCC-001 until the arming input is engaged
and the desired TPS setting is achieved.
Access from the Controller:
From the Main screen press the “SETUP” button, press the “DOWN” arrow button repeatedly until the Data Log
Menu is highlighted and then press the “ENTER” button. Press the "DOWN" arrow button until the "TPS Enable"
option is highlighted, then press "ENTER". Press the “YES” or “NO” button to change the current selection. If the
“NO” button is pressed no change will be made.

Once the TPS Enable option is enabled, you will be sent back to the Data Log Menu where you can either press
the "BACK" button to exit or the "ENTER" button to adjust the TPS Enable Percent and Hysteresis Percent
settings. Refer to Appendix D: Glossary of Terms for an explanation of how a hysteresis works.

Access from the Computer Program:
From the Status screen, press the "Data" button. The "TPS Percent" settings are found in the "Data Log Enable
Parameters" dialog box under the "Options" Tab.
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RPM Enable Option
Enabling the RPM Enable Option disables the data log feature of the NCC-001 until after the Arming Input is
engaged and the desired engine RPM is achieved.

Once the RPM Enable option is enabled, you will be sent back to the Data Log Menu where you can either press
the "BACK" button to exit or the "ENTER" button to adjust the RPM Enable Percent and Hysteresis Percent
settings. Refer to Appendix D: Glossary of Terms for an explanation of how a hysteresis works.

Access from the Computer Program:
From the Status screen, press the "Data" button. The "RPM ON" settings are found in the "Data Log Enable
Parameters" dialog box under the "Options" Tab.

MPH Enable Option
Enabling the MPH Enable Option disables the log data feature of the NCC-001 until the Arming Input is engaged
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and the desired vehicle MPH is achieved.

Once the MPH Enable option is enabled, you will be sent back to the Data Log Menu where you can either press
the "BACK" button to exit or the "ENTER" button to adjust the MPH Enable Percent and Hysteresis Percent
settings. Refer to Appendix D: Glossary of Terms for an explanation of how a hysteresis works.

Access from the Computer Program:
From the Status screen, press the "Data" button. The "MPH ON" settings are found in the "Data Log Enable
Parameters" dialog box under the "Options" Tab.
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8

User Program Files, Data Logs, and Other Software Options
The following sub-sections detail the procedures used to transfer data logs and programs between the Nitrous
Control Center computer program and the NCC-001 controller. This chapter also explains how to view the data log
files that are created by the controller. These options are exclusive to the computer software program, so the
controller will not have the following options available. i.e.- The controller cannot ask for saved programs or data
logs from the computer.

8.1

Managing User-Defined Programs on the Controller and the
Computer
The following options allow the user to manage the programs that are saved into memory on the NCC-001
Controller, as well as those on the computer.

"Program Start" User Program
This option allows the user to choose whether the default user program file or the last user program file opens
when the computer program first opens.
Access from the Computer Program:
From the Status screen, click on the "Options" button in the upper left-hand corner of the window, and then drag
your mouse over the "Program Start" button. Finally, click on either the "Load default user program" button or the
"Load last user program" button.

Open User Program File
This option allows the user to open a saved user program file which can then be modified and/or flashed to the
controller.
Access from the Computer Program:
There are three (3) ways to open a saved User Program File, denoted below by the bullet points.
Press Ctrl+O
From the Status screen, click on the File button in the upper left-hand corner of the window, then click on the
"Open User Program File" button.
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From the Status screen, click on the "Open User Program File" button in the toolbar on the upper left-hand side
of the window, as shown below.

Regardless of which method you used to open the "Open User Program File" window, the computer program
should display the following window for the user to browse the computer to find the desired user program file
(.NCD). Once the user has selected the desired program, click "Open" to open the highlighted user program file
or click "Cancel" to terminate the operation. NOTE: If you have made changes to the current program and have
not saved them, you will be prompted to save the current program.
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Save User Program File
This option allows the user to save a user program file to the computer that was either created in the computer
program or flashed from the controller.
Access from the Computer Program:
There are three (3) ways to save a User Program File, denoted below by the bullet points.
Press Ctrl+S
From the Status screen, click on the File button in the upper left-hand corner of the window, then click on the
"Save User Program File" button.

From the Status screen, click on the "Save User Program File" button in the toolbar on the upper left-hand side
of the window, as shown below.
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Regardless of which method you used to open the "Save User Program File" window, the computer program
should display the following window for the user to name the user program file and to select the desired directory
location to save it in. Once the user has selected the desired program, click "Save" to save the current user
program file or click "Cancel" to terminate the operation.

New User Program File
This option allows the user to create a new user program file that can be calibrated on the computer and flashed to
the controller.
Access from the Computer Program:
There are three (3) ways to create a new User Program File, denoted below by the bullet points.
Press Ctrl+N
From the Status screen, click on the File button in the upper left-hand corner of the window, then click on the
"Save User Program File" button.
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From the Status screen, click on the "Save User Program File" button in the toolbar on the upper left-hand side
of the window, as shown below.

NOTE: If you have made changes to the current program and have not saved them, you will be prompted to save
the current program.

Load User Program from Controller
This option allows the user to upload a user program file from the controller so that it can be further modified or
backed up. This feature is very important as the memory on the controller is only capable of holding three (3)
programs at a time. All other user programs must be backed up by using the Nitrous Control Center software. If
the controller already has three existing user programs and the user attempts to flash a fourth user program to the
controller, the new program will replace one of the three user programs already on the controller, which means that
the program that was replaced is erased out of the controller's memory. The only way to retrieve and reuse the
program is if the program was backed up on the computer.
Access from the Computer Program:
There are three (3) ways to load a user program from the controller, denoted below by the bullet points.
Press Ctrl+Alt+O
From the Status screen, click on the File button in the upper left-hand corner of the window, then click on the
"Load User Program from Controller" button.
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From the Status screen, click on the "Load User Program from Controller" button in the toolbar on the upper lefthand side of the window, as shown below.

Once the "Load User Program from Controller" button has been pressed, a status window will appear showing the
status of the upload, as shown in the illustration below. Once the status window disappears, the upload of the
user program is complete it becomes your current user program on the computer software. NOTE: Since the
uploaded user program becomes the current program, you will be prompted to save any changes to the current
program.

Save User Program to Controller
This option allows the user to flash the current user program file, as well as any other saved user program to the
controller.
Warning: The memory on the controller is only capable of holding one program at a time. This program contains
3 different sets of user defined settings. All other user programs must be backed up by using the Nitrous Control
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Center software. When the you flash a new user program to the controller, the new program will erase the original
program and load the new program onto the controller. The only way to retrieve and reuse the program is if the
program was backed up on the computer.
Access from the Computer Program:
There are three (3) ways to save a User Program File to the controller, denoted below by the bullet points.
Press Ctrl+Alt+S
From the Status screen, click on the File button in the upper left-hand corner of the window, then click on the
"Save User Program to Controller" button.

From the Status screen, click on the "Save User Program to Controller" button in the toolbar on the upper lefthand side of the window, as shown below.

Once the "Save User Program to Controller" button has been pressed, a status window will appear showing the
status of the upload, as shown in the illustration below. Once the status window disappears, the flashing of the
user program is complete and the flashed user program replaces the current program on the controller.

8.2

Managing Data Logs on the Controller and Computer
The following options allow the user to manage and view the data logs that are saved on the computer, as well as
the data log saved into memory on the NCC-001 controller.
Warning: A new data log can not be created until the existing log is erased. The memory in the NCC-001
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controller can only hold one (1) data log at a time, so it is very important to back up prior data logs through the
computer software.

Load Data Log from Controller
This option allows the user to upload a data log from the controller to the computer program where it can be
viewed and saved.
Access from the Computer Program:
There are two (2) ways to load a data log from the controller, denoted below by the bullet points.
From the Status screen, press the "DATA" button. The "Read Data from Controller" option is found in the "NCC
Data Log Commands" dialog box under the "Options" tab.

From the Status screen, click on the "Load Data Log from Controller" button in the toolbar on the upper left-hand
side of the window, as shown below.

Once either of the "Read Data from Controller" buttons are pressed, a dialog box will appear prompting the user to
save any unsaved current data log file to the computer as it would be replaced by the uploaded data log from the
controller.

After the current data log is saved or clicking "NO", the status window will pop up to show the progress of the
upload.
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After the upload is complete, the user will be prompted to erase the data log from the controller, as shown below.

Open Data Log from File
This option allows the user to view a data log that is saved on the computer.
Access from the Computer Program:
There are two (2) ways to open a saved data log, denoted below by the bullet points.
From the Status screen, press the "DATA" button. The "Open" option is found in the "Data Log File" dialog box
under the "Options" tab.

From the Status screen, click on the "Open Data Log from File" button in the toolbar on the upper left-hand side
of the window, as shown below.

If the user has an unsaved data log currently being viewed on the computer, the computer program will prompt the
user to save the data log before opening the saved data log. Then, a windows explorer window will pop up and
prompt the user to select the desired file. Once the desired file is selected, click "Open" to open the data log or
"Cancel" to terminate the operation.
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After the data log is opened, the file name will be displayed in the "Data Log File" dialog box.

The data log can now be viewed under the "Data View" tab.
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Erase Data Log from Controller
This option allows the user to erase a data log off of the NCC-001 controller.

Access from the Computer Program:
From the Status screen, click on the Eraser Icon in the toolbar. Click "YES" to erase the data log from the
controller or "NO" to abort the operation.
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Load NCC User Program from Data Log
This feature allows the user to extract the settings that were used on the controller when the data was read from
the controller. This allows the user to not only be able to view the data log, but to also be able to save the
settings that were used on the controller when the data was read to the computer. If the controller settings are
changed after the data log took place but before the data log was read to the computer, the data log user
program settings will reflect the controller settings when the data was read from the controller, not
when the data was logged. For this reason, it is crucial that the data log is saved to the computer immediately
after the data is logged so that the user program settings truly reflect the settings from when the data log took
place, not from when the data log was uploaded to the computer. This feature is especially useful in the event that
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troubleshooting takes place because it gives the troubleshooter the ability to possibly reproduce the issue. For
racers, it allows you to go back to a previous known configuration, as well as to test and compare the logged data
to the associated NCC-001 settings.
Access from the Computer Program:
From the Status screen, press the "Data" button. The "Load NCC User Program from Data Log" button is found in
the "Data Log File" dialog box under the "Options" Tab.

After Pressing the "Load NCC User Program from Data Log" button, a dialog box will open to confirm that a user
program was extracted from the data log.

8.3

Viewing Data Logs
The following sub-sections explain how to view data logs in the "Nitrous Control Center" computer program. The
data log chart feature allows the user to view readings of the following variables.
Hall Input Frequency
Engine RPM
Nitrous1 Percentage
Fuel1 Percentage
Nitrous2 Percentage
Fuel2 Percentage
Analog Out

TPS Percentage
TPS Voltage
Clutch Percentage
Air-Fuel Ratio
AFR Input Voltage
Analog1 Input
Analog2 Input

Vehicle MPH
Fuel PSI
Nitrous PSI
Gear Position
Battery Voltage
Arming Input
Clutch Input

Shift Input
Timer Output Status
Shift Light Status
Relay1 Output Status
Relay2 Output Status
Stage1 Activation Status
Stage2 Activation Status

The Data Log Chart
The NCC-001 has the ability to log several types of data during each pass. Once the data has been loaded from
the controller, the data can be viewed in the "Data View" tab by clicking the "Data" button, as shown below.
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Viewing Readings on the Data Log Charts
Each individual chart has a label that denotes what the chart is showing, as well as the value of that measurement
at a single point on the chart. To view a reading at any point in the chart, simply click and drag the vertical blue
bar to any point in time on the chart. The chart will then display the readings of each variable being measured
directly beside the label of the variable. In the image below, the variable labels and values are denoted by black
arrow while the time cursor line in denoted by a red arrow.
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Zooming the Chart in or out
The chart can be easily zoomed in or out in two (2) ways. To zoom in or out on a specific point in time, simply
move the vertical blue line to the time location and use the scroll wheel on your computer mouse to zoom in or
out. You can also use the green rectangle below the X-axis by clicking and dragging the ends of the rectangle to
zoom the chart. The ends of the green rectangle show the range of the zoomed charts with respect to the full
length of the chart, so if the entire time span of the chart is being displayed, the green rectangle will span the
entire length of the graph as well. This can be seen in the previous illustration as that chart was zoomed out
completely. Notice in the following illustration how the green rectangle and the tick marks on the X-axis show that
the chart has been zoomed in.

Viewing a Specific Time Interval
The data log chart can be zoomed to a specific time interval by first placing the vertical blue line on either the
beginning or the end time of the desired time interval. Then, double click on the vertical blue line. Your cursor will
now be dragging a highlighted region on the chart, as shown in the first picture below. Drag the highlighted region
of the chart to the other end of the desired interval and single click to zoom in to the desired interval. The second
picture below shows the time interval from 1 second mark to the 6 second mark.
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Scrolling the Chart Along the X-Axis
The data log chart can be scrolled along the X-axis when the chart is zoomed in by clicking and dragging the white
bar that moves along the tick marks on the X-axis. The white bar is denoted by the red arrow in the picture below.
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Selecting Variables to View on the Chart (Chart Properties)
As the bullet points illustrated at the beginning of this section, there are currently 28 variables whose data gets
logged by the controller during a run. Any combination of these variables can be displayed at one time by
specifying the desired variables in the data view properties dialog box.
Access from the Computer Program:
While viewing the data log in the "Data View" tab of the computer program, right-click on the charts and then click
on the "properties" button.

Once in the "chart properties" dialog box, double-click the variables to check or un-check the box. The variables
with the checked boxes will be displayed in the "Data View" tab while the un-checked boxes will not.

Setting Start and End Points of the Run
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Grouping Variables into a Single Chart
The default data log chart is a series of individual charts showing each variable that is checked in the chart
properties dialog box, but you can also choose to show all of the checked variables on one single chart instead.
The chart below shows the variables grouped into a single chart.
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Access from the Computer Program:
Press and hold Ctrl+Alt+G
While viewing the data log in the "Data View" tab of the computer program, right-click on the charts and then
click on the "G-Group All Charts" button.

To toggle the "Group All Charts" option on and off, repeat one of the steps denoted by the bullet points above.

Loading Data View Properties
This option allows the user to open a saved data view properties file.
Access from the Computer Program:
From the Status screen, press the "DATA" button. The "Load Properties" option is found in the "Data View
Properties" dialog box under the "Options" tab.

A windows explorer window will pop up and prompt the user to select the desired file. Once the desired file is
selected, click "Open" to open the data view properties configuration or "Cancel" to terminate the operation.
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Saving Data View Properties
This option allows the user to save the current data view properties.
Access from the Computer Program:
From the Status screen, press the "DATA" button. The "Save Properties" option is found in the "Data View
Properties" dialog box under the "Options" tab.

A windows explorer window will pop up and prompt the user to name and save the current data view properties.
Once the desired name is typed in, click "Save" to save the data view properties configuration or "Cancel" to
terminate the operation.
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Smooth Selected Data
This feature can be used to smooth sharp edges on the data view chart. There are three (3) settings for smoothing
the data, ranging from mild (which modifies the chart the least) to aggressive (which modifies the chart the most).
The graphs can be smoothed further by repeatedly clicking on these buttons. Note that smoothing the data will
make the data less accurate in some places.
Access from the Computer Program:
While viewing the data log in the "Data View" tab of the computer program, click on the label of the desired chart,
right-click on the chart, and then click on the "Smooth Selected Data" button.
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Appendices
The following appendices provide additional information to help clarify which settings to use for your application. A
glossary of selected terms can also be found to provide a better understanding of concepts related to the NCC-001
nitrous controller.

9.1

Appendix A: Pulse Frequency Detailed Explanation
The Pulse Frequency is the number of times per second (Hertz of Hz) the solenoids are turned ON/OFF. This
frequency can be adjusted to one of three values--12.5, 20, and 25 pulses per second.
When the pulse frequency is changed the Nitrous and Fuel Progressive Ramps should be checked. The reason
for this is the way the NCC-001 stores the data. For example a setting of 12.5 Hertz generates fewer data points
over a given time interval than the 25 Hz setting 12.5 pulses per second vs. 25 pulses per second).
When going from a lower frequency setting to the 25 Hertz frequency setting, the total time in seconds for the
Progressive Ramp is decreased. This change in time does NOT effect the Main Timer Timeout period in any way.
The last Percentage setting of the Progressive Ramp is used for the remainder on the Main Timer period. See
Appendix B for more information.
The best way to learn more about this feature is to change pulse frequency and then use the “Nitrous Graph
Setup” to navigate the Progressive Ramp and view the time change per pulse in the Graph Setup screen.
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9.2

Appendix B: Nitrous and Fuel Operation
Progressive Ramp—This adjustability allows the user to tune for rich/lean conditions at different points in the
progressive ramp. Multiple precision timers are included to delay the start of nitrous delivery, advance the fuel
delivery, and to provide an additional +12 volt output to control external devices. A resume ramp has been included
so throttle lift transitions and/or gear change transitions can be controlled.
Arming—The system is armed when either a ground or +12V signal is present on the arming terminals. Once
armed and all other activation criteria are met, the Main Timer begins counting down and is displayed on the main
screen. If the Hold & Wait option is ON the system timers will NOT reset if the activation signal is removed (i.e.throttle lift). If the Hold & Wait option is OFF the system will reset and start over each time the arming signal is
removed and re-applied.
Nitrous Delay—If this function is set the nitrous timers will NOT begin until this time delay has expired. Each
stage has a separate timer delay setting.
Fuel Advance—After the nitrous delay has timed out this setting is checked. If a fuel advance time has been set
the fuel solenoids will begin operation before the nitrous solenoids. For example if a lean spike was occurring the
system could be programmed to deliver a 80% fuel pulse .050 second before the first nitrous solenoid pulse. It is
recommended to check nozzle flow and total volume flow to insure correct fuel delivery.
Nitrous/Fuel Progressive Ramp—Once armed and the delay and fuel advance timers have expired, the system will
pulse the solenoids as programmed. The nitrous and fuel use independent data to allow greater control. When the
end of the progressive ramp is reached the system will use the last percentage in the progressive ramp until the
main timer expires. When the main timer has expired, the only way to reset the system is to remove the arming
signal.
NOTE: It is important to note that the data log, once started, will continue to log data until the 25 seconds is
elapsed, even if the Main timer is reset and started again.
Resume Ramp—This setting controls the Percentage that the system returns to after a throttle lift on the next
Solenoid Pulse. Example-the system is at 80% and the throttle is lifted and re-applied, if the Resume Start
Percent was set at 50% the first pulse would be 40%. The Resume Ramp will increase at the rate of the Resume
Percent Per Pulse setting until the system returns to the Percentage it was at before the throttle lift. If the Fuel
and Analog Out settings are at a higher and/or lower setting they are scaled so they resume at the same rate as
the Nitrous Solenoids.
+12 Volt Timer Output—If a setting of 0.000 is entered the Timer Output will turn ON with the First Pulse of the
Nitrous Solenoid. This output can NOT be disabled and the user must remove any wires connected to the Output
terminal to disable any device connected.
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9.3

Appendix C: Tables and Diagrams
The following Tables and Diagrams have been included to further assist the user with the installation and
calibration of the NCC-001 Nitrous Controller.

TABLE 1: RPM Pulse Counts for various applications
Pulse/
Degree
1 pulse/ 720
degrees
1 pulse/ 360
degrees
2 pulse/ 360
degrees
3 pulse/ 360
degrees
4 pulse/ 360
degrees
5 pulse/ 360
degrees
6 pulse/ 360
degrees

Pulse/rev Common Application(s)
0.5
1

Typical 1 cylinder engines & individual coil ignitions such as GM LS coil trigger wire, ‘99+ V8
Mustang, Suzuki Hayabusa, Kawasaki ZX-14
Typical 2 cylinder engines & wasted spark coil packs such as Viper/SRT10 coil

2

Typical 4 cylinder engines + LS1, LS2 etc.TACH signal

3

Typical 6 cylinder engines

4

Typical 8 cylinder engines

5

Typical 10 cylinder engines

6

Typical 12 cylinder engines

TABLE 2: Common Vehicle ECM/PCM Tachometer Signal Wiring Information
NOTE: The Tachometer wire on an E38 ECU uses the E38 terminals (PN: 0334680003)

Vehicle
Camaro & Firebird
Camaro & Firebird
Camaro & Firebird
Camaro
CK Truck
Corvette
Corvette
Corvette
Corvette
Corvette
Corvette
CTS-V
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Year(s)
1996-1997
1998
1999-2002
2010-2012
2007-2012
1996
1997-1998
1999-2003
2004
2005
2006-2007
2009-2012

ECM/PCM location
Connector C1 (Red)
Connector C2 (Blue)
Connector C2 (Red)
Connector C1 (Black)
Connector C1 (Black)
Connector C1 (Red)
Connector C2 (Blue)
Connector C2 (Red)
Connector C2 (Green)
Connector C1 (Blue)
Connector C1 (Black)
Connector C1 (Blue)

Pin
13
35
10
48
48
13
35
10
10
48
48
25

Wire color
White
White
White
N/A
N/A
White
White
White
White
White
White
N/A
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Circuit #
121
121
121
N/A
N/A
121
121
121
121
121
121
N/A

TABLE 3: Common ECM/PCM Vehicle Speed Wiring Information
Vehicle

Year

Pin

Wire Color

Circuit #

1996-1997

ECM/PCM
Connector
C2 (Black)

Camaro/Firebird

8

817

Camaro/Firebird

1998

C1 (Red)

55

Camaro/Firebird

1999-2002

C2 (Red)

50

Camaro
CK truck

2010-2012
1999-2002

C1 (Black)
C2 (Red)

57
50

CK truck

2003-2006

C2 (Green)

50

CK truck
CK truck
Corvette

2007-2008
2009-2012
1996

C1/X1 (Black)
C1 (Black)
C2 (Black)

57
57
8

Corvette

1997-1998

C1 (Red)

55

Corvette

1999-2003

C2 (Red)

50

Corvette

2004

C2 (Green)

50

Corvette

2005

C1 (Blue)

21

Corvette

2006-2008

C1/X1 (Black)

57

CTS-V
CTS-V
CTS-V
GTO
GTO
SSR

2004-2005
2006-2007
2009-2012
2004
2005-2006
2003-2004

C2 (Green)
C1 (Blue)
C1 (Blue)
C2 (Green)
C1 (Blue)
C2 (Green)

50
39
39
50
21
50

SSR

2005-2006

C1 (Blue)

21

Trailblazer SS

2006

C1 (Blue)

21

Trailblazer SS

2007-2008

C1/X1 (Blue)

39

Dark Green/
White
Dark Green/
White
Dark Green/
White
N/A
Dark Green/
White
Dark Green/
White
Yellow/Black
N/A
Dark Green/
White
Dark Green/
White
Dark Green/
White
Dark Green/
White
Dark Green/
White
Dark Green/
White
Brown
Brown
N/A
Purple/White
Purple/White
Dark Green/
White
Dark Green/
White
Dark Green/
White
Dark Green/
White
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817
817
N/A
817
817
1827
N/A
817
817
817
817
817
817
818
818
N/A
5197
5197
817
817
817
817
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TABLE 4: Wire Gauge Selection Chart for a 12 Volt System
Amps
1
1.5
2
3
4
5
6
7
8
10
11
12
15
18
20
22
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Watts
12
18
24
36
48
60
72
84
96
120
132
144
180
216
240
264

3'
20
20
20
20
20
20
20
20
20
20
20
20
20
20
20
20

5'
20
20
20
20
20
20
20
20
20
20
20
20
20
20
20
18

7'
20
20
20
20
20
20
20
20
20
20
20
20
20
18
18
16

10'
20
20
20
20
20
20
20
20
18
18
18
18
18
16
16
14

15'
20
20
20
20
20
20
20
18
18
18
16
16
16
14
14
12

20'
20
20
20
20
20
20
18
18
16
16
16
16
14
14
12
12

25'
20
20
20
20
20
18
18
16
16
16
14
14
12
12
12
10
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30'
20
20
20
20
18
18
16
16
16
14
14
14
12
12
10
10
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Appendix D: Glossary of Terms
Air to Fuel Ratio (AFR):

Air to Fuel Ratio (AFR) refers to the ratio of the mass of air and fuel inside an
engine at any given time. In theory, the most efficient AFR is where there is
only enough air in the engine to completely burn the fuel, also known as the
Stoichiometric ratio. For standard gasoline, Stoichiometric ratio is 14.7. In
most performance applications, however, the Stoichiometric ratio is rarely
targeted during wide open throttle conditions. Maximum power with standard
gasoline is usually achieved with an AFR of 12.8-13.0. Because Nitrous Oxide
(N2O) contains more oxygen then air does, it is able to burn the fuel at a higher
temperature, creating higher pressure in the cylinders and ultimately more
power. While the added pressure in the combustion chambers increases
horsepower, it can also damage the engine if the AFR is not adjusted
accordingly. In general, you should run a richer AFR when the nitrous is
active.

Hysteresis:

Hysteresis refers to a margin above or below the set range in which a
component is allowed to stay enabled or disabled in order to prevent the
component from switching on and off rapidly. If a thermostat, for example, was
to maintain a temperature of exactly 72 degrees, it would most likely overshoot
72 degrees and then undershoot trying to correct itself. Theoretically, this
would cause the thermostat to switch on and off for an infinite period of time,
exhibiting behavior similar to a sine wave function. As one can imagine, the
continual switching of the thermostat would drastically reduce it's functional life
span. For this reason, thermostats and other devices generally have a built-in
hysteresis function that allow them to stay off or on for longer periods of time.
In the case of the NCC-001 Nitrous Control Center, the nitrous is enabled by
several variables for which a hysteresis can be set. The illustrations below
show the behavior of a 5% hysteresis applied to the maximum and minimum
RPM activation thresholds for nitrous through the NCC-001.
NOTE: These graphs below are for illustration purposes only. The actual RPM
hysteresis value is dependent on the user-defined RPM maximum and
minimum values, as well as the user-defined hysteresis percentage.

As the illustration shows, the nitrous enabled condition remains unchanged
until the user-defined maximum value is reached. The illustration has a userAppendices
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defined maximum value set at 16000 RPM. The illustration has a 5%
hysteresis, which is shown by the dotted navy line. Once the nitrous is
disabled, it will not re-enable until the set point minus the hysteresis is
reached.
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Nitrous oxide (N2O):

Nitrous Oxide (N2O), or Dinitrogen Monoxide, is a chemical compound that is
commonly used in racing applications to increase the power output of an
engine. Nitrous oxide is used in internal combustion engine applications to
increase the amount of oxygen available in the combustion chamber for burning
fuel. The air that we breath in everyday is composed of roughly 78% nitrogen,
21% oxygen, and 1% miscellaneous gases. Nitrous Oxide, on the other hand,
is composed of roughly 64% nitrogen and 36% oxygen. Because nitrous oxide
has a higher concentration of oxygen than air, more fuel can be injected into the
combustion chambers, creating more power output from the engine. Also,
nitrous is undergoing a phase change which cools the engine inlet air and
increases the charge density, further increasing the amount of oxygen available
for combustion.

Throttle Position Sensor
(TPS):

The Throttle Position Sensor (TPS) is the sensor that monitors the position or
the angle of the throttle blade. The throttle position sensor sends a signal,
usually between 0-5 volts, to the ECM or PCM telling it to what degree the
throttle valve is open. Electronic throttle bodies (also known as "drive by wire")
generally have two sensors. One of the sensors will output an increasing signal
as the throttle opens while the other sensor will output a decreasing signal.
This allows the ECM of PCM to compare the two signals to verify that the data
is correct.
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For additional product installation information and technical support, contact
LPE or your LPE products distributor. you can also find technical support and
usage discussions regarding this product and many other LPE products in our
internet forums:
http://www.lingenfelter.com/LPEforumfiles

Photo by SDW Photography

The LPE Camaro drag car pictured above is powered by a 427 CID LSX
engine equipped with a LS9 supercharger and two stages of nitrous. This
4200 lb vehicle currently produces 1250 rwhp. Equipped with a manual
transmission, this vehicle has achieved a best ET to date of 8.99 at 158 mph
and a best 60' of 1.304 seconds.

Lingenfelter Performance Engineering
1557 Winchester Road
Decatur, IN 46733
(260) 724-2552
(260) 724-8761 fax
www.lingenfelter.com
L460150000 NCC-001 Nitrous Control Center v1.2.mnl

